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What is KMyMoney?
Put simply, KMyMoney is a personal finance manager for KDE. It enables users of open source
operating systems to keep careful track of their personal finances by providing a broad array of
financial features and tools.

The principal goals of the project are:

Feature Parity.  KMyMoney intends to provide all important features found in the
commercially-available personal finance managers. Although this release is closer than ever to
that goal, there is still work to be done. 

Ease of Use.  KMyMoney strives to be the easiest open source personal finance manager to use,
especially for the non-technical user. 

Correctness.  Based on tried and tested double entry accounting principles KMyMoney ensures
that your finances are kept in correct order. 

What KMyMoney is not
As a personal finance manager, KMyMoney is not intended to scale to the needs of an average
business. However, it would be possible to create client / supplier / document features through plugins.

7



KMyMoney is not simply a clone of the commercially-available personal finance programs. Although
many of the features present in KMyMoney can be found in other similar applications, KMyMoney
strives to present an individual and unique view of your finances.

Chapter 2. What’s new in this release
We have been working hard to make this release better and easier to use in every way. We have added
a lot of new features to this version and have also made quite a few improvements. We are confident
you will like what you see.

Here are some of the new features found in this release:

An improved look and feel - including a new icon set 

Reports 

Charts 

Forecast 

Budgets 

More flexible schedules 

Database support 

Improved import features 

Improved PGP support 

Chapter 3. Making the most of KMyMoney
Joe (joe1011010) <joe1011010_km@users.sourceforge.net>

Revision 1.0 (2009-05-05)
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Whilst you could go ahead, clicking some buttons and filling in some data, after a time, you could
decide you have done it wrong and start again, even if you did read the documentation on each part of 
KMyMoney.

You will get a more effective system if you spend a little time planning how you are going to use
KMyMoney, so follow the steps given here.

Basic Accounting
Imagine your money as balls, or beans, and to stop them rolling around you keep them in a box, or pot.
Accounting, or Book Keeping, is the process of counting the beans in the pot, or several pots.

You have some money in the pot marked "Cash". You buy some goods, so you take some beans out of
the cash pot and place them into another pot marked "Supplier". The supplier gives you some goods in
exchange for the cash, so you take the beans out of the pot marked "Supplier" and put them in the pot
marked "Goods".

The goods have a value (the price you paid) so you still have the same amount of beans, some
representing cash and some representing goods.

In this case you have two movements of beans, or transactions. Each transaction needs two entries, one
to take beans out and one to put beans in. This is called "double entry book keeping" or "double entry
accounting". The recording of the transactions is done in a "Ledger"; each pot is known as an
"Account" or "Ledger code".

Now you take some goods and give them to a customer, who gives you some cash in exchange. The
goods were worth some beans and, hopefully, the customer has given us more beans than that, so
making a profit. To over simplify, the beans from the Goods pot come back as Cash, but we can split
that as the "Cost of Goods sold" and "Profit". This transaction has three entries; one side of the
"double entry" has been split.

This will be covered properly in setting up accounts for Businesses.

Defining the accounts (personal records)

Most accounts, or pots, above represent a measure of our "Worth". The cash and goods represent our
"Assets"; so does what we are owed if our customers have not yet given us the money. The money we
owe, say if we had not paid our suppliers, are our "Liabilities". These accounts are transferable to Cash
and have a value.

Any pots that cannot be valued are "Income" or "Expense", such as an unpaid phone bill that would be
an expense as we have already made the calls. Although these do not have a value, it is useful to
monitor how much is in each.

In some cases a supplier is a "Liability", in others it is an "Expense". This is something we need to
consider and decide for each case. Similarly, you may set up a loan as a Liability, particularly if you
transfer the money into your bank account, but it could be an Expense if it was to buy some furniture.

Consider how you want to analyze your income and expenses. This will decide how you set them up.
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Finally, consider if you want everything in one set of accounts, or two or more. This may depend on
the legal framework or just how you want to analyze things. Each set of accounts would be handled 
separately.

Defining the accounts (business records)

This is similar to setting up for personal use, but needs to follow legal guidelines. We do not discuss
them here, but you should be aware of what these are.

Mapping your finances to KMyMoney
So, collect up your papers and see the following sections for each item in KMyMoney.

Accounts

These hold a value. Transactions are created against one or more accounts.

Accounts - Asset

These are the accounts which hold your money and possessions that you wish to monitor. The
following types are available:

Checking

Standard bank checking account. 

Savings

Standard bank savings account. 

Cash

Money in your hand or wallet. 

Loan

Loans you make to someone else. 

Investment

Money you invest. 

Asset

Property, collections, etc. 

Accounts - Liability

These are the accounts which represent your debts and money owed that you wish to monitor. The
following types are available:
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Credit card

Standard credit card account. 

Loan

Loans made to you, mortgages, etc. 

Liability

Anything else you owe that is not a loan. 

Institutions

These are completely optional and can be used to group accounts, and show a total value for all
accounts in each group.

Categories

These represent non-managed income and expense accounts that do not have a value. The total value
of transactions is shown against each category. A category or transfer account is required for each 
transaction.

Sub-Categories

Categories can be split into sub-categories, but the sub-category totals are not included in the higher
level category total.

Payees

These are optional for transactions. They are required for Scheduled transactions. A transaction
history, with category, is shown against each payee.

Scheduled transactions

Where regular transactions occur, these can be set up against a Schedule. Transactions are created
from a schedule; any that are overdue can be seen on the home page.

Useful Tips
Unless you keep you money under the floorboards, you probably make use of one or more institutions
where you have accounts which may be in credit or debit. In order to familiarise yourself with the way
KMyMoney works, choose an account you want to track of with KMyMoney and select File>New in
order to set up an account file.

If you have used another personal finance manager, you may be able to import the data from it into 
KMyMoney.
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If you have some regular receipts into or outgoings from this account, go to Payee and enter the names
of both the payers and the payees involved; then go to Schedule and fill in a New Schedule for each
transaction. If you haven’t entered the payee or payer, KMyMoney will offer you the opportunity to do
this in the middle of entering the schedule.

To add other new transactions go to Ledgers; you can add new payees and categories in the middle of
a transaction or by going to Payees or Categories before entering the transaction.

You will probably find that the default Categories do not exactly match your needs; you can easily
delete ones you know you are never going to need and add others that you need. But when you are
entering a transaction, you only have to type a few letters of a category and KMyMoney will offer you
a drop down list of the matching categories from which to choose.

You can add different accounts managed by different institutions; the preferred one will show when
you open KMyMoney but you can quickly switch to any of the others.

When you make a payment, KMyMoney will work out what the next cheque number should be; delete
this if you are not making a cheque payment or edit it if the first cheque you enter is not cheque
number 1. Alternatively, it is possible to switch off auto-increment of cheque numbers.

Every so often you may get statements of your account from the institutions you use; you can
reconcile your KMyMoney accounts against these statements so that you have an accurate statement of
the current state of your finances.

If you go to Reports, you will find several default reports; to customise these, open one similar to the
sort you perfer and then select ’New’ (not ’Copy’); you can then customise this to your needs and
mark it as a preferred report if you wish.

Though KMyMoney is not intended for use in a business context, if you are running a business on
your own and so do not need payroll functions, you will probably find that KMyMoney is sufficiently
customisable to meet your needs particularly as it comes with budgeting and forecasting features and
you can export your customised reports via CSV into other applications.

Chapter 4. Using KMyMoney for the first time
Michael T. Edwardes <mte@users.sourceforge.net>

Revision 1.0 (2009-05-05)
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Reconciliation
Backing up
Contacting the developers / Reporting Bugs

Contacting the developers
Reporting bugs

Running KMyMoney for the first time
Once KMyMoney has fully loaded two windows will be opened. The top window, ’Tip of the Day’
offers one of a series of important or useful pieces of information about the application. 

You are recommended to quickly read through these tips by pressing on the Previous and Next buttons
at the bottom of the window.

Once you have read the tips the window can be closed; it will re-open each time KMyMoney is
started. To stop this default behavior, uncheck the appropriate option on the Tip of the Day window.

Note

Tips can be read at anytime by selecting Show tip of the day from the Help menu within KMyMoney. 

All tips have been extracted from the Frequently Asked Questions list (FAQ) that provides more
detailed help and can be found on the project website and in this manual.
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Please click on Close to close the Tip of the Day dialog.

The main window
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The KMyMoney main window consists of four major parts

A. The menu bar

B. The toolbar

C. The View selector

D. The view

The menu and toolbars provide access to the features of KMyMoney and allow you to Create files or
configure how KMyMoney operates.

The view selector consists of at least eleven icons in the left side of the main window, depending upon
the software provided by your system. More icons could be added by various plugins. By clicking on
an icon, the view window on the right hand side is loaded with the appropriate view of your financial
data. Each view provides a unique representation of your financial situation and allows you to view or
edit the information shown.

The view selector contains the following icons
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 Home: A configurable overview of your current financial situation (or an introduction page
when no data file is open). 

 Institutions: All of your institutions and accounts displayed in a hierarchy. 

 Accounts: All of your accounts displayed in a hierarchy. 

 Schedules: Your recurring bills and deposits. 

 Categories: Special accounts that provide a means for you to group associated transactions. 

 Payees: All Payees used by KMyMoney. 

 Ledgers: Your account transactions. 

 Investments: Your portfolio summary. 

 Reports: A collection of useful reports, providing alternate views of your financial data. 

 Budgets: Your budgets 

 Forecast: This view provides a forecast of your accounts and categories 

 Used by the online banking module to provide feedback on running processes. This is a
view provided by the KBanking plugin and may not be present on your system. 

Creating a new file
KMyMoney keeps all the data about your finances in a file. As was stated in Defining the accounts
(personal records), you can keep more than one set of accounts, but the data for each will be kept in a
separate file, and KMyMoney can only have one file open at a time. See the chapter on File Formats
for more details about KMyMoney’s data files.

To create a new file you can either select File->New from the menu or choose the  icon from the 
toolbar.
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KMyMoney will then open the "New File Setup Wizard" which will guide you through the process of
creating the file.

Since all fields are optional, you can use KMyMoney without entering any information now. Any
information entered here is used only to personalize your file. In the future, it may be used in some
reports and for online banking. If KMyMoney requires any personal information in future releases and
finds none, you will be prompted to enter the relevant data then.

Please enter your name and address or nothing and press Next.

In case you have an address for yourself stored in the KAddressbook, the button Load from
Addressbook is enabled and pressing it imports all information into KMyMoney.

KMyMoney supports multiple currencies. To set your base currency (the currency you use day to day
and which will be used for your reports), select the appropriate entry from the list provided and press
Next. A default will be selected from KMyMoney based upon your locale settings.
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The following page allows you to create an initial account. For the typical KMyMoney user this is a
checking account.
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Enter the name of the account and a possible reference number assigned by the institution managing
the account. Enter the opening date of the account and the opening balance of the account. For
example, you want to use KMyMoney to manage all your finances as of 2008-01-01, then enter the
balance of the account at the beginning of this date. The number can possibly be obtained from a paper
statement. Also enter the name and routing number of the institution, though this information is
optional and only required for online banking purposes.

In case you don’t want to setup an initial account, please uncheck the checkbox

Once finished, press Next to proceed.
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Choose the appropriate country and account template(s). Multiple templates, even from multiple
countries can be selected using a combination of Ctrl  and Shift together with the left mouse button.
The account hierarchy to be setup will be shown in a preview part of the wizard. In case you cannot
find a template that suits your needs, don’t select a template.

Once finished with the template selection press Next to proceed.

The next page of the wizard allows you to setup user preferences. Press Next if you are done and want
to proceed.

20



The last page of the wizard allows you to select the filename that will be used to store your financial
data. An initial filename will be constructed out of your HOME folder and user name. In case the file
exists, a warning will be displayed which reminds you to select a name of a non-existing file.
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Now you have entered all relevant information to create the file. Press Finish and KMyMoney will
create the file for you and open it.

Creating accounts
You can create an account in one of two ways both of which are described here:

Using the menu

To create an account using the menu select Accounts->Add new account. 

Using the Accounts view

To create an account using the accounts view click on the Accounts icon in the view selector and
then right click on the Asset tree icon in the right hand view and select New account from the
popup menu. The Asset tree holds all of your accounts that are an asset. Assets, and all the other
account types, are discussed in more detail later in this manual. 

Tip

Note that KMyMoney uses the context menus a lot throughout the whole application. If you find
yourself stuck trying to figure out how to do something, try right-clicking where you would expect to
see a feature. 
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Creating a new account by either method opens the New Account Wizard. This wizard will take you
step by step through the process of creating an account, gathering the required information at each
step. To navigate through the pages click on the Previous and Next buttons.

Create an account using either of the two previously mentioned methods to continue. A full description
of creating accounts can be found in the Accounts section.

Now that one or more accounts exist in KMyMoney, your account summary is shown in the Home
view. You can create transactions manually in the Ledgers view, or set up automatic transactions
through the Schedules view.

Schedules
Sometimes called a recurring transaction, a Schedule is a transaction that occurs one or more times
over a certain period of time. A typical example is your pay check that you receive every month or
week. Rather than have to enter the transaction details each time you get paid, you can instruct
KMyMoney to create a schedule that will enter a transaction for you when you get paid.

To maintain schedules click on the  Schedules icon in the view selector.

Categories

To maintain categories click on the  Categories icon in the view selector.

A full description of this topic can be found in the Categories section.

Payees

To maintain your list of payees click on the  Payees icon in the view selector.

A full description of this topic can be found in the Payees section.

Quicken Interchange Format (QIF) Import
If you currently use a financial manager application, KMyMoney can import an account’s transactions
as long as they are in the Quicken Interchange Format (QIF). Most financial programs can export this
format and the different applications methods of exporting QIF is not discussed here for brevity.

A full description of this topic can be found in the QIF Import section.

Searching for transactions
KMyMoney provides a useful and powerful transaction search facility in the form of the search dialog.
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The search dialog can be opened from the toolbar using the  Find icon or by selecting Find
Transaction from the Edit menu.

A full description of this topic can be found in the Search section.

Reconciliation
At some point you will want to reconcile the transactions you have entered with the transactions listed
in a statement, be it a bank statement, credit card statement, loan statement, or any other statement.
Reconciliation involves matching what you have entered with what the statement lists. If any
discrepancies are found then either you or the person who created the statement have made a mistake.

To reconcile an account, first select the account, either from Accounts view or from Ledgers view.
Then, either click on the Reconcile icon on the Toolbar, or select Reconcile from the Account menu.

A full description of this topic can be found in the Reconciliation section.

Backing up
Now that you have created some accounts and entered transactions it’s a good idea to perform a
backup. Because the file used by KMyMoney is a standard Unix file you can just copy the file to
another location to back it up or use the dialog provided by KMyMoney. Using the dialog is the
preferred method because if KMyMoney ever starts using other file formats, such as SQL, then it
would be much harder to copy the file manually.

To backup your file through KMyMoney Select Backup from the File menu and enter the folder where
you wish the file to be copied to. If the folder needs mounting first and you have the sufficient
privileges then check the tick box labeled Mount this directory before backing up and click on OK.

The file will be copied to the folder specified with the current date appended to the filename so it is
easy to see the date the file was backed up.

Contacting the developers / Reporting Bugs

Contacting the developers

You can contact the developers through their mailing list 
<kmymoney2-developer@lists.sourceforge.net>.

We’re happy to hear about your experiences using KMyMoney.

Reporting bugs

To report a bug please use the interface provided by KMyMoney by selecting Help->Report Bug and
filling in the required information.
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Writing High Quality Bug Reports

We encourage users to take extra time to write high-quality bug reports when submitting them. This
reduces wasted effort on all sides, as the reporter and the developer who will fix it trade emails until
this information is really in place.

Eli Goldberg wrote the canonical Bug-Writing Guideline, available at 
http://issues.apache.org/bugwritinghelp.html. Generally, you’ll be well-served by following these 
guidelines:

Include your system information.  The Help->Report Bug menu choice will fill this in automatically,
but if you would prefer not to use this interface, we will need to know the version of KMyMoney
you’re running, the version of KDE, the name and version of your distribution, and the version of your
kernel. 

Include a backtrace for crashes.  The backtrace is often the single most useful piece of information
in solving crashes. 

Try to reproduce it.  Let us know if you were able to do so. It’s useful to know whether the bug only
happened once and you couldn’t get it to happen again or happens every time or happens sometimes
but not others. 

Include specific steps.  This is a bad bug report: "I entered a transaction, and KMyMoney crashed." A
much better bug report is: "Using the transaction form, I entered a new transaction in my Credit Card
account. I selected the Transfer tab, entered in an amount, then changed to the Deposit tab, and back to
the Transfer tab. When I returned to the Transfer tab, KMyMoney crashed. This bug is fully
reproducible for me." 

Tell us what you expected to happen.  In some cases, this is obvious, but in more subtle bugs,
sometimes you’ll see a bug report where it is not obvious what the reporter expected to happen.
Always tell us what you think should have happened. 

Consider running with debugging enabled.  By compiling a version configured with
--enable-debug=full you can ensure that the best possible backtraces are generated. If you encounter a
crash, run KMyMoney again from within gdb, and reproduce the crash. When it crashes, type "bt" to
generate a backtrace. 

Running this way is a bit more difficult, so we don’t expect all users to do this. However, if you’re
interested in helping KMyMoney become as stable as possible, this is the best way to do it short of
finding the bug in the code and sending in a patch.

Chapter 5. Institutions
Roger Lum <rogerlum@gmail.com>

Revision 1.0 (2009-05-05)
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Institution Options
New Institution

Account Options

The Institutions screen provides a summary of all the accounts grouped under their respective
institutions. Asset accounts are symbolized with a black arrow, and liability accounts are symbolized
with a red arrow.

The Institutions screen displays several columns, including the type of account and the value of each
account. It also shows the total value of all accounts in each institution.
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Institution Options
Right-clicking an institution name brings up an Institution Options sub-menu, providing you with
several choices. Selecting New Institution... opens the New Institution Dialog, where you can enter all
the necessary information to create a new institution. Selecting Edit Institution... brings up an editable
window with institution details such as name and address. Selecting Delete Institution removes the
entire institution and all its associated accounts. Keep in mind that you will only be able to delete an
institution if you can delete all of its accounts, and you will only be able to delete each associated
account if it has no transactions and no schedules refers to it. Selecting New account... steps you
through the new account process, which is described in more detail in the next section.
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New Institution

NOTE: You must have a file open before you can create a new institution. If you do not have an
existing file, you will need to create a new file. 

Only the name is required in the New Institution Dialog, all other fields are optional. As with the
personal information dialog, this data is not currently used by KMyMoney, but will be required by
future releases for certain features. In particular, the Routing Number and the BIC (Bank Identifier 
Code) will be required for online banking.

Account Options
Right-clicking an account name brings up an Account Options sub-menu. Selecting New account...
steps you through the new account process. Selecting Open Ledger brings you directly to the Ledgers
view or Investments view, depending on the account type. Simply double-clicking an account name
also opens the account. Selecting Edit account brings up a window allowing you to change an
account’s name, start date, associated banking institution, and parent account. Deleting an account is
only possible if there are no transactions associated with that account. Selecting Reconcile... opens up
the Reconcile Wizard, which steps you through the process of comparing your bank account
statements to your electronic entries. More details, as well as information about the other options is
presented in the appropriate sections of this manual.
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Chapter 6. Accounts
Michael T. Edwardes <mte@users.sourceforge.net>

Roger Lum <rogerlum@gmail.com>

Revision 1.0 (2009-08-10)
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Deleting accounts

The Accounts View
The Accounts View provides a summary of all the accounts. There are four different account
categories: Asset, Liability, Income, and Expense. Typical asset accounts include bank accounts, cash,
and investments, while typical liability accounts include credit cards and loans.

There are two ways to view the accounts: List or Icon view, which may be selected by clicking on the
appropriate tab at the top of the view.

In the List view, the accounts are grouped under four headings: Asset, Liability, Income, and Expense.
List view shows the name and balance or value of each account. Income and Expense list the
categories that each transaction is filed under, and provide similar functionality to the Categories
screen. The options and features involving Income and Expense accounts are described in detail in the 
Categories chapter. The rest of this chapter will focus on Asset and Liability account functionality.

In the Icon view, the Asset and Liability accounts are shown with icons indicating the account type.
KMyMoney initially places the icons alphabetically, but you can move the icons to any position you
want, just by dragging the icon with the mouse. Note, however, that just moving an icon does not
currently trigger KMyMoney to think that any data has been changed. This means that you need to
make some other change, such as editing an account or a transaction and saying OK (even without
actually changing any data) so KMyMoney allows you to save the file. The saved file will include the
new icon positions.

Creating an Account
NOTE: You must have a file open before you can create a new account. If you do not have an existing
file, you will need to create a new file. 

To create a new account, you can either select Account->New account... from the menu or choose the 

 icon from the toolbar.

Alternatively, to create an account using the accounts view, click on the Accounts icon in the view
selector and then right click on the Asset tree icon in the right hand view and select New account...
from the popup menu. The Asset tree holds all of your accounts that are an asset. Assets, and all the
other account types, are discussed in more detail later in this manual.

The Institution (Bank) name
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The first step involves selecting an institution for the account. If this is an account for an institution
you have already created, you can select the institution from the dropdown list. If you want to create a
new institution, click on the New Institution button. This will bring up the New Institution Dialog, as
described in the previous section. If this is not a bank account, or if you do not want to use online
banking, you do not need to specify an institution.

The Account Number and the IBAN (International Bank Account Number) are not currently used by
KMyMoney. These fields may be left blank and filled in at a later time; they are only required for
online banking.

To proceed to the next step click on Next.

Account
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This page is used to configure the type of account.

First, enter a name for the account. This name will be used to identify it.

Next, select the type of account from one of the types available from the dropdown list:

Checking

A normal checking account, the type you get with any bank or credit union. 

Savings

A normal savings account, the type you get with any bank or credit union. 

Credit Card

An account to represent your credit card. 

Cash

A general purpose account, typically used for accounts not held at a bank, such as the cash in
your wallet. 

Loan
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An account to manage a loan for money either borrowed or lent. With a Loan account
KMyMoney automatically calculates interest payments to help you track the remaining principal on
the loan. Loans with no interest might use the plain Asset or Liability type below, depending on
whether the money is lent or borrowed. 

Investment

An account to manage an investment such as stocks or investment funds. 

Asset

An account to manage an asset that does not fit in one of the above types. 

Liability

An account to manage a liability such as money you borrowed or a future expense. If interest
needs to be calculated, you might be better using the Loan type above. 

Select the currency to be used for the account from the dropdown list.

Enter the date the account was opened or select it from the calendar using the icon to the right.

Enter the opening balance for the account. If this is an existing bank account this information can be
found on your statement. If it is a new account, the opening balance can be left at zero.

Selecting the Preferred Account check box will allow preferred access in some dialogs and views of 
KMyMoney.

To proceed to the next step click on Next.

Credit Card Accounts

When creating a Credit Card account, you can optionally have KMyMoney create a scheduled 
transaction for you.

33



If you want such a transaction generated, make sure the tick box is checked and enter the required 
information.

Click on Next to continue.

Investment Accounts

For Investment accounts, you have the option to create an associated Brokerage account. For more
information see Investments
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Loan Accounts

Loan accounts are special accounts used to help you manage Loans with interest and scheduled
repayments. By providing KMyMoney with information about the loan, KMyMoney can help you
track interest payments and the remaining principal of the loan.
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On the Details page you enter the general information about the loan.

First, select whether you are borrowing or lending money. If you are borrowing money the loan will be
listed in Accounts under Liabilities. If you are lending money the loan will be listed under Assets.

Next, select the payee or payer of the loan. As always, if the name doesn’t yet exist in the Payees list,
enter it here and KMyMoney will create it for you.

The next three items are for handling Loans on which you’ve already made payments. If you select
Yes in the "Have you made/received any payments yet?" item you can then select whether you want to
record all payments or just those from the beginning of the current year. If you want to record from the
beginning of the current year, you are than asked to input the current balance.

Then, select how often payments will be made and how often interest is compounded. Compounding is
where the interest is added to the amount owed on the loan so that when the interest is next calculated
there will be more interest paid on the interest. It’s common for interest to be compounded at the same
frequency that payments are made.

Next, enter the date the first recorded payment will be made.

Finally, enter information about how the interest rate varies. If the loan is fixed-rate there is nothing to
do. If the rate varies, select Variable in "Type of interest rate" and then enter the interval between
interest rate changes and the date the first change of interest rate is due: KMyMoney will ask you to
update the interest rate when that date arrives.
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The Payments page is where you enter the payment and interest values for the loan.

First, select whether the interest rate is calculated when the payment is received or when it becomes
due. If you don’t know, leave it on the default value.

Next, enter the following values:

Loan amount

The amount of the loan.

Interest rate

The annual percentage interest rate of the loan.

Term

The length of the loan. Enter a number and select either Months or Years. 

Payment (principal and interest)

The amount paid for each loan payment. This is the total of the principal and interest paid with
each payment. 
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Balloon payment

Additional final payment made at the end of the term to pay off the remaining principal of the
loan. For a repayment loan this is often zero. For an interest-only loan this will be the same as the
loan amount. 

Finally, use the Calculate button to check the values you have entered. You must have entered either
all or all but one of the values listed above. If you omit two or more values the button is disabled
because it is not possible to check that the entered values are consistent: in that case you will not be
able to use the Loan account facility in KMyMoney and will instead have to use a Liability or Asset
account to track the loan manually.

If you omit one value KMyMoney will try to calculate it for you. If you have entered all values
KMyMoney will check the values are consistent. KMyMoney will not adjust entered values other than
the "Balloon payment", which it may adjust slightly to deal with rounding. If the values are
inconsistent or KMyMoney cannot calculate the omitted value KMyMoney will let you know so that
you can correct any errors and repeat the calculation.

Once the values are consistent the Next button is enabled and you can advance to the next page.
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The Fees page is where you can enter any fees added to the loan payments.

If there are any fees press the Additional Fees button. The Transaction Split editor will be displayed
for entry of the fees. Any lines added here will be included in the payment schedule for the loan. When
you save the splits the Fees page will display the principal and interest payment, the total additional
fees and the total periodic payment.
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KMyMoney will create a scheduled transaction for your loan. The Schedule page is where you enter
the remaining details needed to create the schedule.

First enter the Category to which loan interest will be assigned. Then enter the account from which the
loan payment will be made.

The page also displays the first payment date for which the Schedule will be created.
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Optionally, KMyMoney can create a transaction representing what was received or paid when the loan
was created.

If you borrowed or lent cash select the account from which or to which the loan amount was paid.

If you borrowed money to purchase a car you can select or create an Asset account to help you track
the value of the new car.

If you re-financed an existing Loan check the "Refinance existing loan" checkbox, select the Loan
account and KMyMoney will create a transfer transaction paying off the existing loan.

If you don’t want to create the payout transaction, check the "Do not create transaction" checkbox.

Parent Account
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This is the penultimate step in creating a new account. A tree of accounts is displayed. The tree will be
of your Asset or Liability accounts, depending on the type of account that is being created.

Select the account you wish contain the new account. If you do not select a parent account, the new
account will be created at the top level.

The Parent Account page is not currently shown for Loans because they cannot be created as
sub-accounts. Also, Investment accounts cannot contain other accounts so they are not shown in the 
tree.

Review and save the account details
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This is the final step in creating a new account. A summary of the information entered is displayed.
Review it, and if everything is OK press the Finish button. Otherwise, either press the Back button to
make corrections or the Cancel button to abandon creating a new account.

NOTE: The Type and Currency cannot at present be changed after the account is created.

Opening / viewing accounts
To open an account in the Ledger view you can either click on the link to the account from the Home

view, or click on the  Ledgers icon in the view selector and select the account in the drop down
box at the top of the view. Alternatively, in the Account view, either double-click the account entry or
right click and select Open ledger.

Editing Account Information
To edit a particular account, right-click that account and choose Edit account.... A details window will
pop-up. This window allows you to change the name and start date of the account, associated banking
institution, and the parent account. Changing the parent account is also possible in the main Accounts
screen, by dragging the account and dropping it on a different parent account. In this window, you can
also create a new banking institution and associate the account with that institution.
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Deleting accounts
To delete an account, first remove all the transactions from that account in the ledger. Next, find the
account in the accounts view and after right clicking on the entry to show the popup menu select
Delete account... from the popup menu.

If you are unable to delete an account which looks like it has no transactions in it, check your filter.
See Settings->Configure KMyMoney->General->Filter. Clear all filters. Set the start date to 1.1.1900
or so.

There may be transactions in your ledger that are not shown, for example, if you have inadvertently
typed in the wrong year when making an entry so that an entry remains outside the opening date of
KMyMoney. This appears beneath the ledger page as remaining funds.

Chapter 7. Categories
Roger Lum <rogerlum@gmail.com>
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The Categories screen provides a summary of all the existing categories under which transactions are
filed. The categories are split into income and expense, and a balance is displayed for each category.
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Creating categories
To create a new category, either select Category New category in the menu, or in the Categories view,
select a parent in the tree, right click and select the New Category option. Either way will open the
Create new categories wizard. Enter the new category name, and select the currency if the default
shown is not correct. In the Hierarchy tab, ensure the required parent account is selected. Finally, in
the Tax tab, there is a check box to enable VAT support, and a check box to include this category in
certain tax related reports.
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Enter the category name any notes and click on OK to save the new category. To create a complete
hierarchy of accounts, separate the names by colons (:) as in Bills:Car:Gasoline.

Editing a Category
To edit a category, right-click on a category name, and choose Edit category. A window comes up
with three tabs: General, Hierarchy and Tax.

The General tab allows you to edit the name of the category and any notes you entered when you
created the category.

The Hierarchy tab allows you to change the parent category. You can also change the parent category
from the main category page by dragging the category to a different parent.

The Tax tab allows you to assign or change VAT category, or alter the automatic VAT assignment. It
also allows you to toggle whether or not the category is included in certain tax related reports.

47



VAT Support
Thomas Baumgart <ipwizard@users.sourceforge.net>

You can turn an expense/income category into a VAT category, which means that it receives all the
splits that actually make up the VAT payment towards the government. You can also enter a specific
percentage rate. entered.

Categories can be assigned a VAT category, which allows KMyMoney to split a transaction for a
category into two parts, one for the category and one for the VAT. Depending on the setting of the
gross/net amount switch, the amount you enter for the transaction is the gross or net amount.

Example: In Germany, there are three VAT percentages (0%, 7%, and 19%). So I have a main
category "VAT paid" and three subcategories, one for each percentage rate. I create these on both the
income and the expense sides so that I have eight categories in total. For the goods I buy, I select one
of the above mentioned categories as the "VAT category assignment".

When I buy goods, I enter them into a transaction. Let’s assume I have selected the gross amount entry
method, once I enter the category and amount, KMyMoney will recognize that there’s a VAT
assignment and calculate the VAT part, create a second split with the VAT account and VAT amount
and reduce the category amount.

The same applies to income categories but the other way around. Hope that makes sense.

Deleting categories
To delete a category, select it in the tree, right click to bring up the popup menu, and select Delete. If
there are any transactions assigned to this category, a popup will allow you to move these to another
parent category. If you try to delete a parent category, a dialog allows the choice of either having the
sub-categories moved up one level or alternatively having them all deleted at the same time.

Chapter 8. Payees
Roger Lum <rogerlum@gmail.com>

Ace Jones <acejones@users.sf.net>
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The Payees screen provides detailed information about all the payees and payers involved in
transactions. The Payees screen is split into two main areas: a payees and payers list and a detail area.

The Payees screen allows for viewing the transactions for the selected payee, updating personal
information associated with a particular payee or payer, and specifying transaction matching criteria.
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Payees List
A list of payees and payers is on the left side of this screen. The payee list is sorted alphabetically. To
sort in reverse alphabetical order, click on the Name title at the top of the list.

Adding a Payee or Payer

To add a payee or payer, right-click on any payee name and choose New payee. This creates a new
payee called "New Payee". Right-click on this payee and select Rename payee to enter the name of the
new payee or payer.

Renaming a Payee or Payer

To rename a payee or payer, simply right-click on the name, select Rename payee and the name
becomes editable. Changing the name will affect the name in all the transactions in which it appears.

Deleting a Payee or Payer

To remove a payee or payer, right-click the name and select Delete payee. If the payee has any
transactions, you will be presented with a dialog that allows you to reassign them to a different payee,
and also a check box to enable a deleted name to be added to the new payee’s matching list.
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Additional Payee Details

Personal Information

To view and edit the personal information associated with a particular payee, select the payee from the
list and select the Address tab. To modify this information, edit the detail area directly and press the
Update button when finished.

Transaction Matching Settings

Overview

KMyMoney has the ability to automatically assign the proper payee to imported transactions. This can
be handy when importing transactions from your bank, when the payee name has extra unnecessary
characters, or worse, if the payee names change.

For example, let’s say your monthly mortgage payment comes in from your bank like this
"SUNTRUST BANK MAPLE VALLEY, GA 111506" one month and then "SUNTRUST BANK
MAPLE VALLEY, GA 121606" the next month. You would really like both of those transactions to
be assigned simply to your payee "SunTrust". The transaction matching feature is for you!
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Setting up

From the Matching tab, you can set the Transaction Matching Settings. You have 3 major options:

No Matching. Disables the feature for this payee. This is the default setting for all payees. 

Match on Payee Name. Enables the feature, and uses the payee name itself as the Match Key 

Match on Key. Enables the feature, and allows you to enter one or more Match Keys of your
choosing. In general, entering a plain string will work perfectly. However, the match keys are
actually regular expressions, so it is possible to match on more complicated patterns. 
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You can also choose whether you want to ignore the case of the Match Key. If you choose this option,
the Match Key "SunTrust" would match "SUNTRUST BANK" or "SunTrust Bank".

Importing Transactions

When you import transactions using the QIF import, or using a plugin such as OFX or AqBanking, the
Match Keys you have set will be considered. If the Match Key for one of your payees is found
anywhere in the payee of the imported transaction, the corresponding payee from your list will be
assigned to that transaction. Thus, a Match Key of "SunTrust" will match "SUNTRUST BANK
MAPLE VALLEY,GA" or even "MORGENSUNTRUST&LOAN". So choose your Match Keys
carefully. 

Note

If a transaction payee matches more than one Match Key, the behaviour is undefined. KMyMoney will
arbitrarily pick one of the matching payees. 

Viewing Transaction History
To view all transactions associated with a particular payee, select the payee from the list and the
Transaction tab in the detail area. Double-clicking a particular transaction will bring you directly to
that transaction in the Ledgers screen.
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Introduction
" Schedules maintain information about transactions that occur one or more times over a specified
period of time. "

Sometimes called a recurring transaction, a schedule provides a means to record information about a
transaction that happen on a regular basis. A common schedule is your salary. Once a month, or maybe
weekly, the company you work for pays you for services rendered. This payment can happen in many
different ways, but each month or week you will receive a payment that needs to be recorded.

Because you know these payments are regularly made to you, you can create a Schedule to record
information about the payment and even create the transaction for you when pay day arrives.

Other types of schedules can also be recorded to reflect money coming in and out of your accounts.
Common expenses, such as utility bills or money transfers, can be recorded with schedules, along with
loan repayments. Scheduling a payment can also provide a useful reminder that you need to make a 
payment.

A schedule consists of two main parts: the scheduling data and the transaction data. The scheduling
data records the occurrence of the schedule, i.e., when the transaction is to be entered into the ledger
and how. The transaction data records the normal details about the transaction, and will be entered in
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to the ledger as-is.

Types of schedules
There are four different types of schedules in the current version of KMyMoney:

Bills

Deposits

Loans

Transfers

Bills

A Bill Schedule is used for money going out of your account, such as a Gym membership or a utility 
bill.

Deposits

A Deposit Schedule is for money coming into your account, such as a pay check.

Loans

A Loan Schedule is a special type of schedule and is created when dealing with Loan accounts.

Transfers

A Transfer Schedule is used for money coming out of one account and going into another, such as
making a credit card payment from your checking account.

The schedule view

Open the schedule view by clicking on the Schedule  icon in the view selector.
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The schedule view consists of a view area with two tabs along with a New Schedule button above it.
The first tab List View shows all schedules, grouped by type. The second tab Calendar View is
described in its own section below.

To create a new schedule click on the button. For Bill, Deposit, and Transfer schedules, KMyMoney
will display the new schedule dialog. Loan schedules are handled differently, and are described in the
section on Loans.

The new schedule dialog
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A new dialog window is now shown, prompting for the schedule and transaction data. The requested
data includes the following:

A.  Schedule Name

B.  Next due date

C.  Frequency

D.  Payment method

E.  Amount

F.  Other transaction details

G.  Schedule options

Filling in the fields

Enter the name and the date of the next occurrence of this schedule into their respective fields. The
name is how the schedule will be shown in the list view. Specify how often the schedule should occur,
using the Frequency field and drop down list. For example "every 6 weeks" or "every 3 months". If the
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amount varies transaction to transaction make sure to check the Estimate check box and you will be
prompted for the correct amount when it is entered into the ledger. Fill in all the transaction fields as
you would normally with the ledger view.

Modifying the schedule behavior

At the bottom of the dialog are some optional fields that can modify how the schedule behaves. If the
schedule occurs on a weekend you can choose whether to enter the transaction on the weekend day,
the previous Friday, or the next Monday. Typically this option is used to replicate some real world
operation such as a bank transaction.

Letting KMyMoney enter the transaction into the register

To let KMyMoney automatically enter the transaction for you when needed, make sure that the check
box labeled Enter this schedule into the ledger automatically when it is due is checked. Otherwise,
when the transaction is due to be entered, KMyMoney will open a dialog box asking you to confirm
that you want it to be entered. This behavior is configurable, and more information can be found in the
Settings section.

Letting KMyMoney know when the schedule will finish

If you know how many transactions are left or when they are due to finish, this information can be
entered so the transactions are not entered indefinitely. Check the appropriate check box and enter the
appropriate information. Only the date or the number of transactions remaining is needed because the
other can be calculated.

When you have entered all the necessary information click on OK to continue.

Editing schedules
To edit a schedule simply select the entry in the list and right click to bring up the context menu and
select Edit. This will bring up a dialog similar to the New Schedule dialog, where you can alter the
necessary data.

Deleting schedules
To delete a schedule simply select the entry in the list and right click to bring up the context menu and
select Delete.

The calendar view
The calendar tab presents the schedules in a calendar format so it is easier to see when they occur. To
switch to the calendar view click on the Calendar View tab.
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The calendar type can be changed using the Select Style button. Currently only two types exist: Week
and Month. The monthly view is the default, and is usually the most useful. Navigate through the dates
using the controls as you would with the date input control.

On any day with scheduled transactions, the number of transactions scheduled for that day is displayed
on the calendar.

To view the schedule(s) that fall on that day, move the mouse cursor over the highlight and a popup
window will be displayed allowing you to view the schedule summary.
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If more than one schedule falls on that day you can cycle through them using the arrow buttons in the
upper corners of the popup window.

If you find that the display is cluttered with schedules and you only want to view one type of schedule,
then this is possible from the Select Schedules dropdown. After clicking on this button the different
schedule types are listed and are checked by default

To remove a type from the calendar view simply uncheck it in the list.

Entering scheduled transactions
Entering a scheduled transaction means actually entering a transaction into the appropriate ledger,
using the details specified in the schedule. Scheduled transactions can be entered in one of four
different ways:

60



Manually by right clicking on the list entry

Manually via the popup window in the calendar view

KMyMoney can enter them with or without your interaction upon startup 

KMyMoney can enter them with your interaction during online banking or import of an electronic
bank statement 

Manually entering scheduled transactions

You can enter a scheduled transaction manually by right clicking on the list entry and selecting Enter
from the popup menu or by clicking on the Enter button on the popup window in the calendar view.

Confirming the transaction to enter

After selecting either method the Enter Scheduled Transaction dialog window is shown prompting you
with the required information that was entered when you created the schedule.

This information can be changed, and the changes can be applied to just this one instance of the
schedule or to all subsequent transactions. After checking that all the data is correct clicking on OK
will add the transaction to the ledger and update the next due date of the schedule to the next
occurence. If you have changed any of the transaction data a further confirmation of what you changed
will be displayed, giving you a final chance to accept or reject the changes.
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Select what you want to do with the information presented and click OK or Cancel.

Letting KMyMoney enter the scheduled transaction(s) for you

Alternatively, KMyMoney can check which schedules are due upon startup and enter them for you if
the appropriate option was checked when setting up the schedule.

If the option was not checked then KMyMoney will open the previously mentioned dialog and you can
follow the steps mentioned there. KMyMoney will also open the dialog if the amount is an estimate so
you can enter the real amount.

You can also opt to have KMyMoney not check which transactions are scheduled on startup by
deselecting the option in the Settings dialog and any overdue transaction or transactions due ’today’
will be shown in the Home view for you to enter manually.

Chapter 10. Ledgers
Michael T. Edwardes <mte@users.sourceforge.net>

Roger Lum <rogerlum@gmail.com>
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The Ledger View
The Ledger view is where most of the functionality of KMyMoney lies. This view is for examining
and entering transaction data in the various accounts. The view is split into three main areas: the filter
area, the transaction list, and the input area.

This view allows for several key actions: searching and viewing transactions, entering new
transactions, and editing or deleting existing transactions. Other functionality includes modifying
account details and reconciling the account.
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The view has three elements:

The filter area

The transaction list

The transaction input form, which may or may not appear, depending upon your configuration. 

The filter area

64



You can select an account via the account dropdown list at the top of the view area. Note that
depending upon the type of the account the transaction input form at the bottom of the view changes.

To the right of the account dropdown list, are two additional fields. The search box acts as a filter on
the transactions that are shown in the list view. Only transactions that include the text typed in the
search box are displayed. The text specified can be in any of the fields of the transaction. The status
field is a dropdown list. Only transactions of the type selected in that dropdown are displayed.

The transaction list

After you have entered a transaction, it is displayed in the transaction list. You can also change
transaction properties or even create new transactions directly in the list. In the transactions list, the
default arrangement of transactions is sorted by date with the most recent transaction on the bottom.
Clicking the Right Mouse Button on the header of the transaction list brings up a dialog that allows
you to change the sort order of the transactions. You can change the default sort order in the Sorting 
tab section of the KMyMoney Settings Chapter.
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The transaction input form

The exact layout of the bottom area of the ledger view depends on your configuration and the type of
account being displayed. However, it generally includes fields for all the details of a single transaction,
as well as buttons for various actions that can apply to a transaction. It is described in more detail in
the following sections.

Entering Transactions
There are two methods of entering transactions into the ledger: using the transaction input form and
entering the data directly into the transaction list. The transaction input form is displayed by default
and this is the method we will discuss first.

The fields in the input area match the information fields in the transactions list. Additional fields
include the Memo field, for a more detailed description of the transaction, and a Category selection.
The Split button allows you to split the transaction into multiple categories.

Using the transaction input form

The transaction input form at the bottom of the ledger view is the interface for creating transactions.

Depending upon the type or method of transaction you wish to enter there are several tabs available on
the transaction form. Click on the tab that best describes your transaction (deposit, transfer, or
withdrawal) and the form will load several fields ready for your input.

Please note that the actual transaction method is not used directly by KMyMoney but is purely for
grouping/reporting purposes.

If you are unsure which method to choose simply use Deposit for any money going into the account,
Withdrawal for money coming out of the account, and Transfer for money moving from one account
to another. The transaction methods and the differences between them are discussed in more detail 
elsewhere.

66



Select the transaction method by clicking on one of the tabs.

The fields of a transaction

Enter the information using the following notes on the available fields. Note that many fields have
’Auto Completion’ turned on. That is, if you start typing, KMyMoney will offer alternatives matching
the characters you have entered so far. To select an entry click on it using the mouse or keyboard, or if
your entry is not listed keep typing to add the new value. The next time you type the value in,
KMyMoney will find it for you after the first few characters have been input.

The Payee

The Payee is who the money came from/to. If the payee is a new entry KMyMoney will ask if you
wish to add this to the list of Payees. Any other information related to a payee or payer, such as
address details can be updated in the Payees view later.

The Category

The Category associates a transaction with an income or expense category for accounting and
reporting purposes, and enables you to group certain transactions. Type the name of the category into
the required field. If you have entered the category and it does not exist then KMyMoney will ask if
you want to create a new one.

If you wish to associate parts of the transaction with different categories, KMyMoney can let you do
that. An example transaction might be a cash machine withdrawal of 50 of which you use 10 on food,
20 on beer and 20 as spare cash. The transaction will therefore be assigned three categories: Food,
Beer, and Cash. To do this, you need to use Split Transactions, which is described in more detail 
below.

See the special KMyMoney fields section for more information on how to use this field.

The Memo

A multi-line memo can be entered if you wish to help you remember what the transaction was for.

The Check Number

The check number can be entered if needed. Note that the check number can always be visible if
desired. This is configured in the Settings dialog.

The Date

The transaction’s posting date must be entered to specify when the transaction took place. See the
special KMyMoney fields section for more information on how the date input field can be used to
make entering dates quicker and easier.

The Amount

Finally, enter the transaction amount into the required field. Note that a simple calculator can be
displayed, either by clicking the icon to the right of the amount field, or by entering the % character
into the field, or by entering a formula, as in 12 + 3. When entering the plus sign, the calculator will be 
opened.
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When you are satisfied that all the fields have been filled in correctly, click on Enter. If you
accidentally press or click on Enter before you have finished entering all the data, click on Edit to
resume entering the data.

Directly inputting transactions into the list

The second method of entering transactions into the ledger involves editing the transaction list itself 
directly.

To do this you must first let KMyMoney know that you don’t want to use the transaction form by
opening the settings dialog and unchecking the Show transaction form option.

This is performed by selecting Settings Configure KMyMoney from the menu bar and selecting the 

 Register icon from the list on the left. The option to uncheck is labeled Show transaction form.
When finished click on OK to be ready to directly enter transactions.

Starting the edit

To enter a new transaction into the register you can now either click on an empty entry, press 
Ctrl +Ins, or click New at the foot of the window. The Up and Down arrow keys let you navigate
through the list. After pressing Enter or double clicking on an entry, the transaction list displays the
fields required to enter the transaction and waits for input.

To move through the fields press the Tab key and when done press Enter to save the changes or Esc
to cancel.

In case the option Use Enter to move between fields is selected, the Enter moves to the next field just
as the TAB  key except for the last entry field where it stores the data.

Which method you use to enter transactions is up to you and is a matter of personal preference.

Split Transactions
The Split transaction feature allows you to divide up a transaction into multiple categories,
representing, for example, the different items bought with a single purchase at a store.
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To enter a split transaction, using either the transaction input form or the transaction list, start a new
transaction as normal, including entering the total amount. Then, instead of selecting a category, click
the Split button. If you have already selected a category, that becomes the first entry in the split editor 
screen.

In the split editor screen, double-click an empty line to enter a new sub-transaction or press Ctrl +Ins.
Specify the category, add an (optional) memo, and enter the amount. To save this part of the split,
press the green check mark under the category. To cancel, press the red cross.

After entering a split, the bottom of the split editor shows how much of the total transaction is still
unassigned. After entering all the splits, press the OK button to save the entire transaction. If there is
still an unassigned amount, you will be prompted to either return to editing the splits, change the total
transaction amount, or leave part of the transaction unassigned.

Note that the category field in the transaction input form or the transaction list now displays Split 
transaction.

Editing transactions
To edit a transaction, select it in the list view and either click on Edit in the transaction input form or
right click on the entry and select Edit from the popup menu. If you are editing transactions directly in
the list you can edit the transaction simply by double clicking on an entry or by pressing Enter when a
transaction is highlighted.
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Deleting transactions
To delete a transaction, select it in the list view, right click on the entry, and select Delete from the
popup menu when it appears, or click Delete on the transaction form.

Matching Transactions
Generally, when importing transactions, either via QIF, OFX, or HBCI, KMyMoney will
automatically attempt to match them against existing transactions. To allow for differences in the
dates, there is a default setting of 4 days, which may be changed in the settings - Register/Import. Any
transactions so matched will be highlighted in green. On completion of the import, you should review
these and either accept or unmatch them.

If you should find that an imported transaction was not automatically matched with an existing
transaction when it should have matched, then it is possible to match them manually. Note that there is
a difference between manually matching two transactions and simply deleting one of them, even
though they may appear to have the same effect. Specifically with OFX or HBCI, it is important not to
delete the imported transaction, because you will find that the next time you import your transactions,
the deleted transaction shows up again. This is because modern import formats like OFX and HBCI
use a "Transaction ID" to identify transactions. When you delete the imported transaction, the
transaction ID goes with it, so the importer has no way to know this transaction was already imported.

The solution is to tell KMyMoney that the transactions are the same, using the manual matching
interface. This allows you to match an imported transaction with a hand-entered (non-imported)
transaction. To do so, select one of the transactions to be matched by clicking on it, then select the
other by left clicking on it while pressing the Ctrl key, and then select Match from the context menu.
This changes the background color to a pale green. This will match and combine the two transactions
together. The values of both transactions must be the same for the match to work, except that the dates
may differ by the window specified in the settings, as described above. If you are happy with the
result, right click the matched transaction, then select Accept.

During import of online statements - either directly or by importing a downloaded file - KMyMoney
performs matching as best as it can based on the name of the payee and the amount of the transaction.
In case of an invalid match, a matched transaction can be unmatched.

Note

The matching interface will not allow you to match two transactions which have both been imported.
Likewise, it won’t allow matching between two transactions which have both been entered by hand. 

Understanding the Cleared State
A transaction can have one of three states: non-reconciled, cleared (C), and reconciled (R). When you
enter a transaction, it has state non-reconciled. Once the bank posts the transaction, the user can clear it
and thus transform it to state (C). When you receive a statement from the bank, all cleared transactions
should be on the statement.
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When you reconcile your account, you actually mark the statements as cleared and check that the
difference between the beginning balance and the cleared transactions equals the ending balance of the
statement. When this is the case, you can ’finish reconciling’ which actually changes the state of all
cleared transactions (C) to reconciled (R).

If you try to edit a transaction with at least one split marked as reconciled (R), you will be warned.

A fourth state is defined (frozen (F)) but there’s currently no way to set it. It is reserved for future use.
Nevertheless, if a transaction has at least one split in state frozen it cannot be edited anymore.

Changing Transaction Settings
There are several settings options that change the appearance and behaviour of the ledger view in
terms of transactions. These settings are found by selecting Settings Configure KMyMoney from the

menu bar, and selecting the  Register icon from the list on the left.

Most of the settings are self explanatory. For clarity, several of the settings are explained below.

Show transaction form (under the Display tab) - toggle to hide the transaction input area at the
bottom of this screen. Transactions can still be entered directly into an empty line at the end of
the transaction list, through an automatic compact entry area. 

These images show what direct transaction entry looks like compared to the transaction form.

The transaction input form
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Transactions entered directly

Keep changes when selecting a different transaction/split - by selecting the next line in the
transaction list or split editor, the changes are kept, instead of the default behaviour where you
have to push the green check mark to save changes. 

Other Functionality
Additional options are available from the Transaction Options menu, accessed by right-clicking any
transaction in the list.
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Options include jumping to the Payee’s page, creating a schedule, and changing the reconciled or
cleared indication.

To edit the account information from the ledger view, select Account from the menu bar. From this
menu, you can change the account details, or bring up the Reconcile menu, which allows you to match
transactions against an official bank statement or credit card notice.

Chapter 11. Investments
Ace Jones <acejones@users.sourceforge.net>

Revision 1.0 (2009-06-14)
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Investments in KMyMoney

Investments

Investments are instruments for investing money that are traded on a market. Stocks, bonds, and
mutual funds are the most common investments; so they are the ones supported most directly. Futures,
commodities, options, and more complex derivatives are also sometimes used, but KMyMoney has no
special functionality for them. As long as they behave like a stock or a bond, they can be tracked 
easily.

Base Currency

Each investment has a Base Currency. This is the currency in which it is traded. When a price quote is
entered for an investment, the currency of the value given is always its base currency. A stock on the
NYSE (New York Stock Exchange) would be in US dollars, and one on an Australian market would
be in Australian dollars.

Investment Accounts

Investment Accounts hold a collection of investments. An Investment account contains transactions,
such as buys and sells, of those investments. All transactions in an Investment account must relate to a
specific investment. There is no separate "cash balance" in an investment account. For that, you need a
Brokerage Account.

Brokerage Accounts

An investment account often has an associated Brokerage Account. This is also sometimes referred to
as a "Cash Account". Investment accounts cannot contain cash transactions, like a transfer from your
bank. When a stock is sold, the proceeds are typically placed in the Brokerage Account.

When you create an Investment Account, you have the option of creating an associated Brokerage
Account with it.

Creating an Investment Account
The first step on the path to working with investments is to create an account to hold your investments.
Choose Account->New account... to begin the process of adding a new account. Create an account as
usual, making sure to choose "Investment" as the type of account.
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To work with the new investment account, navigate to the Investments view, and choose the account
you have just created from the Select Account dropdown box.

Adding Investments to Your Account
To add individual Investments to your Investment Account, navigate to the Investments view, and
choose the account where the investment is held from the Select Account drop-down box.

Right-click the mouse in the empty space in the view. This brings up the Investment Options context
menu. Choose New... from this menu. This launches the New Investment Wizard which you use to
create your new Investment.

New Investment Wizard

The first thing you’ll be asked to enter is the type of investment, whether it’s a stock, bond, etc.

Next, the investment details page is presented. The following information is entered on this page:

Trading Symbol. The ticker symbol used to identify the investment on whatever market it trades.
KMyMoney requires a trading symbol for all investments; however some investments do not
have symbols. In this case, you will need to make up a symbol for it. 

Full name. The friendly, readable name of the investment you’re creating, e.g., "Advanced Micro
Devices, Inc." This name is also referred to as the security. 

Fraction. The degree of precision to which your holdings are measured. For example, in the US
most mutual funds measure holdings to three decimal places, so you would enter 1000 in this
field. Stocks are often measured to only whole units, so you could enter 1 for a stock like this. 

Trading market. Where the stock trades. This is an optional field which is provided for your
convenience. This information is not used anywhere else in KMyMoney. 

Identification. An optional field to enter additional identification information you might like to
keep track of. Again, this information is not used anywhere else. 

Trading currency. The underlying currency in which this investment trades on its market. 

Price entry. Choose whether the price will be entered as an individual price, or as the total for all
shares. 

If you are using Online Quotes, ensure that the symbol exactly matches the symbol used by your quote
source. Yahoo covers most of the world’s markets, and requires a suffix on the end of symbols outside
the US. For example, Rubicon Limited on the New Zealand market should be entered as "RBC.NZ".

Finally, you’re presented with the Online Update screen. This is where you tell KMyMoney how you
would like to update the prices of your investment. The following items are set here:

Use Finance::Quote. This is an option for GnuCash users who are used to this style of quotes.
Most users can leave this unchecked. 
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Online Source. The online source you’d like to use for this particular investment. The most
common choice is "Yahoo". Try that first, and if the investment cannot be found using this source,
then experiment with the others. 

Factor. A multiplier that should be applied to quotes retrieved for this investment. This is most
commonly needed for UK stocks where the price quoted is in pence (1/100), and the stock is
denominated in pounds. In this case, enter 0,01 for the Factor. 

Editing an Investment
The Investment view window lists your current holdings in this account, along with their symbol,
value, and price. Right-click the mouse on any of the investments to bring up the Investment Options
context menu, where you have the option to add, edit, or delete individual investments from this
account. Also, you can update the price of your investments here either manually or via their online
source. In addition, it is possible to close an empty account, or to reopen a closed account.

Investment Transactions

Investment transactions are entered and edited in the ledger view, as with other kinds of accounts.
However, the fields are different, and vary depending on the investment transaction type or activity.
Investment transactions have some additional elements:

Activity

Security

Account

Shares, Price, & Total Amount

Fees

Interest category
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Activity

The Activity for an investment transaction describes what action is happening to the stock. The
following activities are supported:

Buy/Sell. Use to record purchases or sales of individual investments. This action requires an
account to transfer the funds from/to. 

Dividend/Yield. Also known as a "Cash Dividend", this action is used for when you receive an
interest or dividend disbursement from your investment. This action requires an account to
transfer the funds from/to. 

Reinvest Dividend. This is a dividend where the proceeds are re-invested back into the
investment. 

Add/Remove Shares. A simple increase or decrease in your balance. This should be used very
rarely, because it’s uncommon for shares to just show up in your account (or disappear) unless
it’s a purchase or a sale. 

Split Shares. Used when the stock is split. Enter the ratio of the split in the "Split Ratio" field. For
example, in a 3:2 split, enter 1.5 

Security

Each investment transaction must be associated with an individual security, which is here just another
name for an investment. Choose the investment name when adding or editing a transaction. The
symbol will be displayed when viewing it.

Account

For any transactions which generate or require money, you must enter the account where the money is
transferred to/from. If your investment account has an associated brokerage account, it’s usually best
to transfer the funds there. This applies to funds for purchase or sale of the investment, as well as for
fees paid or interest or dividends earned.

Shares, Price & Total Amount

For buy, sell, and cash dividend transactions, the number of shares, the price per share, and the total
amount of the transaction must be established. You can enter any two of these, and KMyMoney will
calculate the third. It’s usually best to enter just the total amount and the number of shares, because
these are the known facts of the transaction. The price per share can be calculated from these.

Fees

With many investment transactions you can include the fees (or commission) you paid the broker. If
you enter a category for the fee, then a field will be shown to the right where you can enter the amount
of the fee. If you need to enter more than one fee for the transaction, you can use the Split Transactions
feature. In this case, when you complete entering all the splits, the total amount of the fees will be
shown to the right.
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Interest

This is how you enter an interest or dividend payment from an invenstment. As with fees, if you enter
a category, then a field will be shown to the right where you can enter the amount. You can also use
the split transaction feature, if required.

Working With Foreign Investments
KMyMoney supports multiple currencies and investments, and you may want to combine the two.
However, doing so requires extra care. As noted above, when you added an investment, you had to
specify its trading currency. This might not be the same as your base currency, and it also might not be
the same as the account in which you hold the stock or the account where you transfer your funds
to/from for buys/sells.

Consider a hypothetical case. Your base currency is USD. You have an investment account in EUR,
and a brokerage account also in EUR. In that account, you hold shares of TietoEnator, which is traded
in SEK.

When you enter a buy transaction on this investment, use SEK as the currency. So if you buy 100
shares at a price of SEK 248.00, for a total of SEK 24,800.00, enter these values in the transaction.

When you choose the brokerage account to fund the transfer, you’ll be warned that it’s in a different 
currency.
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When you finish the transaction, you will be prompted for a price update to the investment account’s
currency, in this case, SEK -> EUR. Review the documentation on Entering Prices Manually for more
information on the price dialog.

If you then switch over to the brokerage account, you will see the transaction as EUR 2,254.54,
assuming an exchange rate is 11.0000 SEK / EUR.

Updating Prices
There are two ways of updating the prices for your investments. You can either enter the new price
manually or have KMyMoney fetch it from the web. 

Manual Price Updates

You can enter prices for your investments using the same Price Editor as used for currencies.

Online Price Quotes

KMyMoney has the ability to download the latest prices for your investments and currencies via the
web. 

How Online Quotes Work

At your request, KMyMoney will fetch a page from the web that contains the latest price for each
item. By default, prices are fetched from http://finance.yahoo.com, and are subject to the terms and
conditions of that site.
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The online quote lookup uses the investment’s trading symbol to find the price. Therefore, it’s
important to set the symbol correctly. Yahoo supports stocks from most major world markets, so it’s
usually just a matter of finding the correct symbol. For example, TietoEnator trades on the Stockholm
Stock Exchange market, and its Yahoo symbol is TIEN.ST.

To find the trading symbol for a security supported by Yahoo, use the "Symbol Lookup" feature at 
http://finance.yahoo.com.

Assigning a Quote Source

In order to get online price quotes, you first have to enable it for each investment or currency you want
updated, by setting a "Online Quote Source". This is the name of the service from which the quote
should be fetched. KMyMoney ships with several sources to choose from. Yahoo is the recommended
default source, and should work for most investments and all currencies.

To assign a quote source to an investment, navigate to the investment summary view for the account in
which the security is held. Edit the security by right-clicking it and selecting Edit Investment .... In the
Investment Detail Wizard, click Next twice, for the Online Update section. In the Online source
dropdown box, select the online source.

Versions of KMyMoney starting with 0.9 contain support for the Finance::Quote package for
obtaining online quotes. This is intended primarily as a convenience for those users converting from
the GnuCash finance package, which uses it as its native method. If you do select this option, you
should see a different list of sources, those supported by Finance::Quote. If the list is empty, it
suggests that the package is not properly installed. See their web site at 
http://finance-quote.sourceforge.net for more information.

Adjusting a quote

Some online sources do not report the price in a base quantity (e.g., EUR) but in a fraction (e.g., Cent).
Using this information as price will produce wrong values for your investments.

If this is the case for your online source, you can use the Factor field to enter an adjusting factor. For
the above mentioned example the factor would be 0.01.

The Factor field is only available if a Quote Source has been selected.

Fetching Quotes

Typically, you will update the prices for all your investments and currencies at once. Choose the
Tools->Update Stock and Currency Prices... menu option to bring up the online price quotes dialog.
Press Update All to fetch quotes for all investments and currencies in your KMyMoney file.
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Adding or Editing Quote Sources

Adding or editing quote sources is not recommended for anyone but the most technical user. You
should feel comfortable reading HTML and writing complex regular expressions. If this doesn’t sound
like you, we recommend writing to the developer’s list if none of the quote sources work for you.
Ideally, please point us to a web page where these quotes can be obtained.

If you do feel up to the challenge, here’s how it works. The quote sources are contained in the settings
dialog. Choose Settings->Configure KMyMoney. From there, choose the Online Quotes section. You
can choose an existing source to edit, or create a new one. When you are done with your changes, be
sure to press the Update button before exiting the dialog. Your changes are not saved by default.

The first thing to worry about in an online quote source is the URL. This is the page that is fetched
from the web. You will see a %1 in all sources, and a %2 in currency sources. For investments, %1 is
replaced by the trading symbol. For currencies, %1 is replaced by the From currency, and %2 is
replaced by the To currency. This URL is then fetched, all HTML tags are removed, and that stripped
file is then sent to the page parser.
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Note that the URL can also be a file: URL, which the quote fetcher takes to mean an executable script.
It will pass any command-line arguments to it that you have specified, and feed the stdout to the page
parser. For example, you might have a script called getquote.sh that contains custom quote logic,
taking the symbol as a single parameter. Your URL would be "file:/path/to/getquote.sh %1".

The page parser looks for a symbol, a date, and a price. Regular expressions tell it how to extract those
items from the page. Please review the documentation for the QRegExp class at
http://qt.nokia.com/doc/3.3/qregexp.html#1 for the exact makeup of the regular expressions. There
should be exactly one capture expression, surrounded by parentheses, in each regexp. The date format
further tells the date parser the order of year, month, and day. This date format should always be in the
form "%x %x %x". where x is y, m, or d. The date parser is very smart. "%m %d %y" will parse
"December 31st, 2005" as easily as "12/31/05". Two digit years are interpreted as being in the range of 
1950-2049.

Unimplemented Features
Certain common features that are normally found with investments are not yet implemented in
KMyMoney. These include: Derivatives (options, futures, etc), capital gains, and tax reporting for 
investments.
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KMyMoney supports the use of multiple currencies in different accounts. For example, you can set up
a bank account in Euro, another in British Pounds, and still have your credit card account in US 
Dollars.

Base currency
Once you create a KMyMoney file you will be asked for the base currency. The base currency is the
one that all income and expense categories use and that reports will be based on. Usually, the base
currency is the currency you use in your country. If not otherwise selected, new accounts will use this
currency as the default.

82

http://qt.nokia.com/doc/3.3/qregexp.html#1


Account setup
If you create a new account you have the option to specify the currency in which it will be managed.
The ledger for the account will then show all values in the selected currency. The new account wizard
defaults this setting to the base currency.

Entering transactions using different currencies
Whenever a transaction is entered that refers to more than one currency, the exchange rate editor pops
up and allows you to enter an exchange rate. Initially, the current price available from the price
database will be used as exchange rate. See Entering exchange rates for currencies for more
information on how to provide exchange rates manually and obtain online price information.

Optionally, the exchange rate is saved in the price database once entered by the user.
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Exchange rates for currencies

Entering prices manually

The price database editor allows you to enter exchange rates between currencies or prices for
investments. You can pull it up using the Tools->Prices... menu option.

In KMyMoney a "Price" is the price of one currency in terms of a second currency. For example, as I
write this, the price of 1 USD in terms of 1 EUR is 0.83; that is, 1 USD costs 0.83 EUR. The first
currency is the one being bought or sold, and the second one is the currency used to buy or sell it.

When you press the New button, you get the New Price Entry dialog. Enter the first currency (USD in
the example above) in the Security field. Enter the second currency (EUR in the example above) in the
Currency field. Enter the effective date of the price in the Date field.
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Online currency updates

KMyMoney will fetch currency conversions from the web. Once you have entered a single price for a
pair of currencies, the online quote feature will always list that pair amongst its options.

See the section on Online Price Quotes in the Investments chapter for more details.

Chapter 13. Reconciliation
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What is reconciliation?
Reconciliation is the process of matching the transactions you have entered into KMyMoney with the
transactions listed for that account by the institution. This is most commonly done with the list of
transactions in a statement, be it a bank statement, credit card statement, loan statement, or any other
statement. It can also be done against an on-line listing of the account, although this is less common. If
any discrepancies are found, then either you or the person who created the statement have made a 
mistake.

To reconcile an account, choose your account from the drop down box and click on the  
Reconcile icon, select Account->Reconcile... or use the key combination Ctl+Shift+R.
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The reconciliation wizard
This will open the reconciliation wizard. The first page of the wizard briefly describes the process you
will follow. Click on Next to actually start the wizard.

Statement details

The statement date, starting balance, and ending balance can be found in your statement. Make sure
that the figures match and click on the Next button. If the figures do not match then enter the figures as
listed on your statement and click on the Next button.
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Interest

If the statement reconciliation is on a bank account or any account with interest and/or charges fees,
then enter these values in the appropriate fields. A category can be assigned for each of these amounts.
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Note

The interest field is for interest you gained. If you have to pay interest, e.g., for a credit card account,
this has to be entered as a charge.

Click on Finish to start matching your statement to what you have entered. Note that this completes
the Reconciliation Wizard, but not the process of reconciliation. As described below, you still need to
clear transactions and then tell KMyMoney that the account is reconciled.

Clearing transactions

To mark a transaction as cleared, click on the C column in the list view. A transaction is cleared when
it matches the transaction on your statement.

During the reconciliation, any transaction can be edited to make it match the statement, and new
transactions can be created as usual.
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Completing Reconciliation

Finishing Reconciliation

The command frame (just below the transaction list area) displays the statement amount and the
cleared amount. When the difference is zero then the account is reconciled and you can click the
Finish button. When you do this, KMyMoney takes all the transactions which have been marked as
cleared and marks them as reconciled, and the C column changes to ’R’ to reflect the change. In
addition, it saves the changes and records that the account has been reconciled.

Postponing Reconciliation

To postpone the reconciliation to a later time, click on the Postpone button. Any edits you have made
to any transactions, such as marking them cleared, can still be saved before you exit KMyMoney, but
you will have to run the reconciliation wizard again in order to reconcile the account. If you exit
KMyMoney before clicking either Finish or Postpone, it has the same effect as clicking Postpone.

Chapter 14. Reports
Ace Jones <acejones@users.sourceforge.net>
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@Rob: Pls update Screenshot to include new Charts section

The Reports View lists all available reports, grouped under the following headings.

Income and Expenses

The reports in this section show your income and expenses either for the current month or for each
month in the current year. Of course, the duration of the overall report and the duration captured by
each column can be configured to your liking. Graphs and Pie Charts also may be produced.

Net Worth

Here there are reports that describe your net worth, either at the current moment, every month for the
current year, or every year of your history. In addition, there is a 7-day Cash Flow Forecast and a Net
Worth Graph. There are also reports to get the balances for all of your accounts at any given point in 
time.
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Transactions

This section includes reports that list individual transactions. This is the best way to print your account
register for a specific period of time. The transactions printed can be grouped together according to
your liking by choosing the appropriate report, such as: 

By Account

By Category

By Month or Week

By Payee

Cash Flow

The Cash Flow report is similar to a Transaction report, but it displays all cash-flow related 
transactions.

Investments

These reports help you keep track of your investments. They only include investment accounts. There
are a variety of presentation filters and styles, as shown in this partial list.

Investment Transactions: Similar to a Transactions report, and includes the share price and 
quantities.

Investment Holdings by Account: Shows the current shares, price, and value for each account.

Investment Holdings by Type: Same as the previous report, but organizes the accounts by type
(Stock, Mutual Fund, etc)

Investment Performance by Account: Shows the annualized performance over any period of time.
This performs a cash flow analysis of all money coming into and going out of the account. As a
result, this is a very accurate picture of how well your investments are doing.

Investment Performance by Type: Same as the previous report, but organizes the accounts by
type (Stock, Mutual Fund, etc)

There are also graphs for Investment Prices and Investment Worth.

Taxes

The tax reports are just like the transactions reports, with the addition that only Tax related categories
are included. This allows you to flag certain categories as being tax-related, and then get one big report
at the end of the year to see them all in one place. They may be listed either by Category or by Payee,
and for the last fiscal year.
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Budgeting

The budgeting reports are similar to net worth reports, but the reports can display the budget for a
given year, or even compare it to the actual income and expenses for the same period.

Forecast

The forecast reports are just like the net worth reports, but they use the information to display forecast
information. You can display the information at various levels and for the timeframe of your choosing.

General Information

These reports display non-transaction information about schedules, accounts, and loans.

Charts

If Charts are enabled, this section lists all the reports which are marked to display a graphical chart as
the default. They are also listed in one of the other sections, but they are also aggregated here for your
easy reference.

Favorites

This section lists all the reports you have marked as a favorite in the report configuration dialog. They
are still listed in one of the other sections, but they are also aggregated here for your easy reference.
Favorite reports are also included on the financial summary page for even easier reference.

Configuring Reports

To access the report configuration dialog, bring up the report you wish to configure, and press the
Configure button at the top of the report.

Working With Reports
There are a number of actions you can take on each report. You can access these by right-clicking the
report name in the list of reports. Alternately, once you have run a report, there are buttons across the
top of the view to invoke each of these:

Chart: Only present if the report is capable of displaying a chart. Clicking this option toggles
between the report and the chart.

Configure: Change the properties of this report. You can customize the report to your liking and
save it for future use.

New: Create a new customized report based on the selected report.

Copy: The report output can be copied to the clipboard to paste them in another application, like a
spreadsheet, for further analysis.
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Export: Reports can be saved in HTML or CSV format.

Delete: Customized reports can be deleted. The default reports that ship with KMyMoney cannot
be deleted.

Close: Close the current report.

Configuring Reports

Working with custom reports

You can configure the default reports or create your own from them by selecting ’New’ and then
configuring the new report. When you select ’Configure’ you will be presented with the Report Tab.
Initially, it is named the same as the old report with "Custom" added to the end. You can change the
name to whatever you want. You can even name your custom reports the same as a default report, or
the same as another custom report. Also, you can always use the Comment field to further distinguish 
reports.

The Report Configuration dialog has a number of tabs across the top. Each tab displays options for
configuring different aspects of the report.

Report Tab

On this tab, you set the basic properties of this report. 

Report Name: Choose a name for this report.

Comment: Enter a comment to help you remember the details of this report.

Convert values to base currency: Select this option to convert all values in the report to your base
currency. Leave it unchecked if you’d like to see values in their original currency. If currencies
are not converted, then subtotals will not be shown.
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Mark as favorite report: Check this to cause this report to show up on the home page and in the
group of Favorite Reports.

Rows/Columns Tab

On this tab, you configure how you would like the rows and columns to be selected and organized.
This tab presents different configuration options depending on the style of report you have selected.

@Rob: Screenshot of rows/columns tab from an income/expense report

For income/expense and net worth reports: 

Columns: Choose how large of a time period each column should encompass

Rows: Choose what kind of accounts to display as the rows of this report

Detail: Choose the level of detail required for this report.

The following levels of detail are available: 

All: Show every category or account.

Top-Level: Show only the highest-level categories or accounts, and roll up the sums of the
subordinates categories or accounts into those values.

Groups: Show only the totals of the income, expenses, assets, or liabilities.

Total: Show only the grand totals line.

For transaction reports: 

Organize by: Choose how to group the transactions in this report
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Show Columns: Choose which columns should be shown in the report. The date and transaction
amount are always shown.

Include only Tax Categories: Only show categories which have been marked as tax-related.

Include only Investment Accounts: Only show transactions from investment accounts.

Include only Loan Accounts: Only show transactions from loan accounts.

Chart Tab

@Rob: Screenshot of chart tab

This tab allows you to configure what the report should look like when it is displayed as a chart. See
the Graphs & Charts section for more explanation of the charting functions. 

Chart Type: The visual format of chart desired.

Show grid lines: Whether to print horizontal and vertical grid lines on the chart.

Draw values on chart: Whether to print the data values on the chart itself for chosen data points.

Show chart by default: Whether this report should first be displayed as a chart when it’s opened.

Line width: The width of data lines on the chart.

Other Tabs

The other tabs in this dialog are the same as in the Search Transactions interface. Please refer to the 
documentation on that interface for details on the other tabs.

Graphs & Charts

Viewing as a Chart

Each report can be viewed in either textual form or graphical (chart) form. The same report
configuration parameters are used in either case. You can easily jump back and forth between the
textual and graphical forms by pressing the Chart or Report buttons along the top of the report view.

Care should be taken to limit the amount of data you choose to display on a chart. If you are not
careful, using the same configuration for both textual and graphical forms means it’s possible to
configure a chart to be visually cluttered, unappealing, and uninformative. KMyMoney will not force
you to keep your charts readable and useful!

Available Chart Types
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Line Graph

@Rob: Screenshot of a simple line graph

A line graph is one of the most simple forms of a chart. There is one line for each series. (Usually a
series is a single account or category; see below for more details on that.) The time periods stretch out
along the bottom axis, and the currency values are along the left.

The detail level for each line is controlled in the Rows/Columns Tab of chart configuration. If you
choose the "Top-Level" detail level, there will be one line for each of the top-most accounts or
categories which show the sum total of all underlying accounts or categories. If you choose "Groups"
it will instead show one line each for Income, Expenses, Assets, or Liabilities, depending on the other 
settings.

Bar Graph

@Rob: Screenshot of a simple bar graph

The bar graph works exactly the same as the line graph, except there is one bar for each series in each
time slice.

Pie Chart

@Rob: Screenshot of a simple pie chart

The pie chart is the most simple chart available. It shows only one time slice, as opposed to showing
the values across time. This chart shows only the totals column of whatever report is selected. If your
report is configured to NOT convert values to the base currency, there will be no totals column, and
therefore this report is not useful.

Ring Chart

@Rob: Screenshot of a simple ring chart

The ring chart is very similar to a pie chart, except there is one "ring" for each time slice in the report.
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GnuCash Importer
Tony Bloomfield <tonybloom@users.sourceforge.net>

GnuCash Files

The KMyMoney GnuCash importer handles direct reading of standard (XML) files as produced by
GnuCash versions 1.8 and 2.0. The following are not supported:

import of database (Postgres) data

import of ’multi-book’ files

import into an existing KMyMoney file

import of small-business specific features (Employees, Invoices, etc.)

export to GnuCash files.

The import will probably only work correctly if presented with a valid file. It is recommended that the
GnuCash ’Check & Repair All’ function (in the Actions menu) be run before attempting to import.

Files can be opened by specifying the file name on the command line (kmymoney <filepath>), or by
means of the KMyMoney File->Open (Ctrl-O ) or File->Import menu items.

The similarity between the two products means that much day-to-day data can be imported in a
straightforward fashion. However, there are some areas where differences arise, and various options
are provided to deal with these. The following sections will describe some of these differences;
understanding them should lead to a smoother importation.
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Similarities, Differences, and Terminology

Small Business Usage

It should be noted that KMyMoney is a personal finance manager, and as such, does not directly
support any of the business features of GnuCash, such as tax tables, payroll, and tracking of lots. Any
Accounts Payable or Receivable accounts found in a file will be imported as Liability or Asset
accounts respectively.

Accounts

Account types

For both products, the highest level of structure in the file is the account. KMyMoney supports 5 main
types of account: Asset, Liability, Income, Expense and Equity, each of which may have various
subtypes, e.g., Checking, Credit Card, etc.. KMyMoney includes a ’standard’ account for each of these
five types, and all other accounts are held subordinate to one of these. KMyMoney enforces more
consistency (or less flexibility, depending on your point of view) between account types than does
GnuCash, and the importer will correct any inconsistencies it detects. This may result in a slightly
different account structure, though this can, within reason, be amended after the import is complete.

Categories

KMyMoney uses the term Category to denote an account of an Income or Expense type. Unlike
GnuCash, these are not considered as ’ledger’ accounts, and entry of transactions folder into categories
is not supported; allocations are made during transaction entry into other account types.

Structure and Placeholders

GnuCash supports the use of Placeholder accounts. In effect, these are just read-only accounts into
which no transactions can be entered, but which function in an analogous fashion to folders in a folder
structure, as a holder for other accounts. Though KMyMoney does not support this feature as such, it
does provide a parent/child account relationship, so the importer simulates placeholders by creating
empty accounts.

Account Type map
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GnuCash type KMyMoney type

BANK Checking

CHECKING Checking

SAVINGS Savings

ASSET Asset

CASH Cash

CURRENCY Cash

MONEYMRKT MoneyMarket

STOCK Stock

MUTUAL Stock

EQUITY Equity

LIABILITY Liability

CREDIT CreditCard

INCOME Income

EXPENSE Expense

RECEIVABLE Asset

PAYABLE Liability

Transactions and Splits

Balanced transactions

As with GnuCash, data is entered in the form of transactions, each generally consisting of 2 or more
split entries. In fact, valid GnuCash transactions will always contain at least 2 splits, and to conform to
GnuCash’s double-entry bookkeeping standard, these must be in monetary balance (i.e., they must
balance out to zero). KMyMoney encourages, but does not enforce, this standard, but any imported
transaction which is not balanced will be marked in the ledger view as having a problem.

Payees

KMyMoney prefers that all transactions have a Payee (a generic term that encompasses both payees
and payers), and unlike GnuCash, a list of these payees is maintained. Payee names are generated by
the importer from the GnuCash transaction’s Description field.

Transfers

KMyMoney uses the term Transfer to describe a transaction which does not involve a Category, but
only transfers money between Asset and/or Liability accounts.
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Reconcile

KMyMoney provides an account reconciliation function similar to that of GnuCash, and the
corresponding transaction status will be imported.

Commodities

GnuCash uses the term Commodity to cover both currencies and non-currency assets. These are
treated separately in KMyMoney.

Currencies

KMyMoney has built-in support for all foreign currency types. KMyMoney also requires that the user
specify a base currency, this being the default currency for new accounts. The importer will attempt to
determine the most likely base currency, though this choice may be rejected in favour of an alternative.

(NOTE: KMyMoney does not currently support accounts denominated in ’defunct’ currencies (except
those replaced by the Euro). At present, it will be necessary to remove any such accounts from your
GnuCash file before importing. We hope to improve on this situation in a future release.)

Securities and Investments

Non-currency assets (normally stocks and bonds) are called Securities by KMyMoney, and represent
the main difference between the two products, in that KMyMoney requires any account denominated
in a security to be subordinate to an Investment Account. This is described in more detail in the
chapter on Investments. Though users may have implemented such a relationship, GnuCash imposes
no defined structure on it, so the importer is unable to detect it and perform an automatic conversion.
Three options are therefore made available:

Create a separate Investment account for each security, with the same name as the security

Create a single Investment account which will act as ’parent’ for all security accounts

Create several Investment accounts, and assign securities to them as directed by the user.

It depends entirely on user requirements which of these options is relevant in each situation, and in
some cases, manual restructuring of accounts after importation may be necessary.

Prices and currency rates

Security prices and currency exchange rates as displayed in the GnuCash Price Editor will be
imported. In addition, price and rate entries will be generated from all transactions involving securities
and multiple currencies.

Online Quotes

For obtaining online price and currency rate quotations, GnuCash uses a package called
Finance::Quote. Recent versions of KMyMoney contain support for this package for obtaining stock
quotes, and this will be used by default when importing data. You may however elect to convert to the
native method used by KMyMoney which is covered in more detail in online quotes.
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If you choose to do so, the following dialog will allow selection of a ’native’ KMyMoney price source,
or a user-defined source, for each account for which online quotes are required. However, the stock
(ticker) symbol will be imported unchanged. Since this symbol will almost certainly be different in the
two packages, it will need to be manually edited after completion of the import process. Future
currency rate updates will not use Finance::Quote, and will always use the native retrieval method.

Scheduled Transactions

KMyMoney does not retain the separation made in GnuCash between template transactions and their
frequency of occurrence. Transaction data will be duplicated if the same template is used in different
schedules, but this is not likely to be of great significance.
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Schedule types

KMyMoney classifies all schedules as one of three types, Bills, Deposits, or Transfers. Since GnuCash
does not make such a distinction, the importer attempts to determine the classification from the
accounts and direction of money movements. It may be that in some cases incorrect assumptions are
made, and these will need manual correction.

Suspect Schedules

Some features of GnuCash scheduled transactions are not available in KMyMoney, so the importer
tries in each case to reach a reasonable compromise in converting the data. These transactions will be
flagged as suspect, and the user will be given the option of editing them directly during the import
process. Examples of situations which may cause this are:

some frequency intervals supported in GnuCash are not currently available in KMyMoney

KMyMoney does not support the use of formulae and variables in amount fields

complex cases which have not yet been identified for import.

Despite best efforts, it is possible that, due to the many options involved, a scheduled transaction may
cause a fatal error within KMyMoney. If this sort of problem seems to be occurring, the importer
offers the option to drop all suspect schedules.

Reports

KMyMoney provides a comprehensive selection of configurable reports, described in more detail in 
Reports. These will not necessarily, however, match precisely those reports available in GnuCash.

Selecting Importer Options

103



Investment Handling

See "Securities and Investments" above.

Online Quotes

Turn this off if you wish to use the native method for future online price quotes.
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See "Online Quotes" above.

Scheduled Transactions

See "Scheduled Transactions" above.

Decoding Options

If your native language is written in letters or symbols which are different from those used in the
’Latin’ languages (i.e., generally Western European), these are represented in a special fashion
(’encoded’) in your GnuCash file. If these letters are not displayed correctly on your screen, then they
must be decoded. Currently, it is often not possible to detect accurately which form of decoding must
be used, so you may need to set this option and select an entry from the list. In general, the first item in
the list will be that which is considered appropriate for your locale (i.e., the country and language
which was selected as native when your operating system was installed), so this should be tried first.
Since the import process does not overwrite your GnuCash file, you are free to experiment with any of
these selections.

Transaction Notes option

Under some usage conditions, non-split GnuCash transactions may contain residual, often incorrect,
memo data which is not normally visible to the user. When imported into KMyMoney however, due to
display differences, this data can become visible. Often, these transactions will have a Notes field
describing the real purpose of the transaction. If this option is selected, these notes, if present, will be
used to override the extraneous memo data.

Debug Options

These need only be used in the event of import problems. If you have such problems, you should also
report them to the KMyMoney developer list 
<kmymoney2-developer@lists.sourceforge.net>. Note that the traces produced by
these options may contain data of a confidential nature, and the Anonymize option should be used if
they are to be made publicly available.

Import Report

At the end of processing, the importer produces a report showing the number of different entities
processed, and any errors or anomalies encountered. This report will be displayed on screen, and may
be saved to a file for later review. A full report may contain the following sections:

Record counts

Inconsistencies in account types and actions taken

Details of suspect schedules
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QIF Importer
Thomas Baumgart <ipwizard@users.sourceforge.net>

QIF format considered harmful

Generally speaking, the QIF format should be avoided wherever possible. It is a poor choice for
transporting financial data. Among other things, QIF suffers from these problems:

Lack of standardized format: Different versions of the same program will impart different
meanings to the same element.

Lack of transaction identifier: Because there is no ID number associated with each transaction,
matching duplicate transactions is haphazard at best.

Lack of expressiveness: The grammar is really simple, and cannot portray the depth of financial
information found in today’s financial environment.

This is generally why Intuit stopped supporting QIF input at all with Quicken 2005. If you have the
option of getting data some other way, like OFX, always choose that option.

How to import a QIF file

To import a QIF file, first ensure you have a valid KMyMoney file open. Then select Import QIF from
the File menu.
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The resulting dialog prompts for the QIF filename allowing you to locate the file by clicking on the
Browse button.

Also, KMyMoney differentiates between the import of a bank statement file and historic data exported
from another application. The default is to import a bank statement file. In case you are importing data
from your previous personal finance manager application select the appropriate option.

In general the default QIF profile should work with your QIF data. In some cases it might become
necessary to use a modified QIF profile. See the next section for more details on that subject.

Click on Import to import the QIF file.

KMyMoney will start scanning the file to determine the formats used to represent dates and numbers.
In case it cannot determine a date format unambiguously, KMyMoney will ask the user to select one
from the list of possible date formats.

Next, KMyMoney imports the data and creates all necessary objects, such as payee information,
accounts and category records, and stock price information. Wherever possible, existing transactions
will be matched against the imported information. A progress bar is shown and updated during the
import process.

In case KMyMoney could not detect the name of the account to be imported, the user will be asked to
select the account into which the data should be imported. If the account does not already exist in your
file, a new account can be created by clicking on Create.

At the end of the import, KMyMoney shows a statement import statistics window.
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After importing, all of the imported transactions will be shown with a yellow background in the ledger
view. In case KMyMoney was able to match an imported transaction with an already existing
transaction, the background is shown in light green.

The next step is to verify the imported data and accept it. This is a general process and also applies to
imports from other sources. It is outlined in a separate section of this document.

Note

The colors used to mark imported and matched transactions are customizable and may be different in
your environment.

Setting up a QIF profile

Because there is no universally standard format for a QIF file, different vendors have taken liberties
with the format, and introduced their own nuances. The QIF Profile allows KMyMoney to know about
the peculiarities of your file. To edit an existing QIF Profile, or to create a new one, press the "New"
button on the QIF Import dialog, near the profile selector.
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Note

Previous versions of KMyMoney used to have a tab for date and amount specifications. KMyMoney
now determines those settings by scanning the file. If it cannot figure out all settings, it will interrogate
the user during import.

Transaction matching

As noted previously, one of the major drawbacks of the QIF format is the lack of a unique identifier
for each transaction. Thus, if you import a QIF file and some of the transactions are already in your
ledger, you may get duplicates. KMyMoney attempts to get around this by looking for transactions
that look similar to those you already have. If it finds something that looks like the same transaction, it
will match the apparent duplicate.

This can be a problem if you have transactions that look too similar but are actually different. In this
case, you can unmatch those transactions later in the ledger view.

Writing an import filter

Sometimes you may have data in a custom format, like comma-separated-values (CSV), or something
else unique to your situation. You can still import that file into KMyMoney using a QIF Import Filter.
A filter is a custom program you write which takes your special file as input, and produces a QIF file
as output. This can be a shell script, a perl script, a compiled program written in C/C++, or anything
else you can dream of, as long as the system can run it.

To use it, edit your favorite QIF Profile, and select the Filter tab. Enter the location of your filter
program where prompted. Then, whenever you do a QIF import using this profile, the file you select
for importing will be run through your filter first.

A common problem is to convert a list of comma-separated-values into a QIF file. This is a textbook
case for the awk tool. Create a script called csv2qif.awk, with the following two lines as contents:

109



        BEGIN { FS=","; print "!Type:Bank" }

        { print "D"$1; print "T"$2; print "N"$3; print "P"$4; print "M"$5; print "^" }

Then, change the QIF keys (D,T,N,P,M) to match the order of your csv data. Set the input filter to awk
-f csv2qif.awk.

Another problem sometimes arises in the encoding of QIF files. KMyMoney expects files to be UTF8
encoded. If your file is encoded in something else, it can be useful to convert it to UTF8. For example
to convert it from iso-8859-1, you would set the input filter to recode iso-8859-1..utf-8.

Special KMyMoney QIF extensions

As already mentioned, one of the major drawbacks of the QIF format is the lack of a unique identifier
for each transaction. If you are writing your own QIF file creator (or filter, as described above), you
can overcome this problem. KMyMoney supports the ’#’ field. The importer will interpret this as a
unique transaction ID, and disregard the record if the transaction is already in the system.

QIF Exporter
To export one of your accounts to a QIF file, choose the Export QIF from the File menu. You will be
prompted for which single account to export, what file to export it to, and what QIF Profile to use.

Note

At the moment, QIF Exporter does not handle export of investments.
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OFX Importer Plugin
Ace Jones <acejones@users.sourceforge.net>

Thomas Baumgart <ipwizard@users.sourceforge.net>

Getting the plugin

KMyMoney will import OFX files painlessly. However, this functionality is not built into the core
program. You must obtain and install the OFX Importer Plugin. Once that is installed, the command to
import OFX files will automatically show up under the "File | Import" menu.

Note that many prepackaged versions of KMyMoney were built with the OFX importer already
included or available as a separate package. If the OFX importer does not seem to be installed in your
version, the first place to check is in the same place you got your base KMyMoney package.

If you have installed from RPM, the OFX Importer Plugin is contained within the kmymoney-ofx
RPM. It should be available from whatever source you got the base KMyMoney RPM. If you have
built from sources, all you need to do is have preferrably the libOFX 0.9 development headers and
libraries installed on your system. The KMyMoney build process will detect these and compile the
plugin. libOFX 0.8.2 is supported as well, but some features are not supported with this version of the 
library.
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Should you run into trouble trying to compile KMyMoney, and you are certain you have the correct
version of libOFX installed, please contact the developers list 
<kmymoney2-developer@lists.sourceforge.net> for assistance. Include a copy of your
config.log file, compressed first via gzip.

Importing an OFX file

The most basic way to import an OFX file is to choose the importer from the menu bar. From the File
menu, choose Import, and then OFX. If OFX does not show up under Import, you do not have the
OFX Importer Plugin installed correctly. Please see the previous section.

The first thing the importer will do is ask you into which account to import the transactions. If there
are transactions from multiple accounts in your file, you will be asked this question multiple times.

After importing, some of your transactions may be shown with an exclamation mark on a yellow
triangle in the ledger. This is because they need to be assigned a category. The importer was not able
to automatically assign a category based on your past transaction history. You can edit each
transaction in the ledger to assign a category, and the mark will be removed.

Please note that this section describes the "native" OFX importer. OFX files may also be imported
using the AqBanking Importer Plugin if you have installed that. Note that the two importers do behave
slightly differently, and they are written and supported by two different developers.

Importing Investments

Please note that if you are importing a file with investment transactions, those investments must first
exist in your KMyMoney file. The trading symbol is used to match, so please ensure that the symbol
in KMyMoney is exactly the same as the one in the file you’re importing.

Web Connect

The easiest way to import an OFX file is to set up Web Connect. Visit your bank’s web site, and click
on a link to download an OFX file. Your browser should ask you what program you would like to use
to open the program. Point your browser to KMyMoney. It will then import the downloaded OFX file
into the KMyMoney file you most recently had open. You can also change the file associations of your
desktop environment, and have KMyMoney open the OFX file automatically for you.

If you need to import the OFX file into some other KMyMoney file, load up that file in KMyMoney
first, and then visit your bank’s web site.

Direct Connect

OFX Direct Connect is now supported in KMyMoney. This gives you the ability to contact your bank
directly to obtain statements. In the future, there will be more help written, and this will be moved to
its own section.

To enable this feature, you must compile KMyMoney with the --enable-ofxbanking switch (now the 
default).
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Please be warned: Many banks require a separate signup, will give you a separate password or PIN,
and may even charge you a separate fee for this service. No bank directly supports KMyMoney. You
will have to tell them you want to bank directly from MS Money or Quicken.

The first step is to configure each account for which you wish to download statements. Go to the
Accounts view, right click on the account you wish to configure, and choose "Map to online
account...". In case more than one online banking plugin is installed on your system you will be asked
which one to use. For the internal OFX method select KMyMoney OFX. A list of banks will be
downloaded from the Internet and a wizard will guide you through choosing a bank, entering your
username and password, and selecting an account. Should you find that your bank is not listed, then it
may still be possible to use the manual option. Your bank may be able to provide the required
parameters, or you may have to do some research to find them.

Once you have an account set up with online banking, go to the ledger for that account. Then from the
"Account" menu, choose "Update account...". This will connect to your bank, and download a
statement for the last 60 days.

Exporting an OFX file

It is not possible to export your data as an OFX file currently. If you are interested to contribute in this
area, please contact the libofx development team for details.

Writing Importer Plugins
KMyMoney contains explicit support for importer plugins. If you have a custom format, and you
would like to write an importer plugin, we would value your contribution. To do so, you’ll need to
compile the program from source. Then use the OFX Importer Plugin as an example.

Chapter 16. Loans
Darin Strait <darin.strait@ashdar-partners.com>

Revision 1.0 (2009-08-03)
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Understanding Loans
This section provides an overview of how KMyMoney handles loans. Loan regulations and customs
vary from locality to locality. For detailed explanations of loans, as well as information on local
regulations and customs, please see other resources.

A loan is an agreement under which a borrower receives money from a lender and agrees to repay the
money at some future date. KMyMoney allows you to track loans by which you, as borrower, borrow
money from or, as lender, lend money to someone else. Most individuals borrow more than they lend,
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so you will generally be the borrower and a finance company will generally be the lender. If you lend
money to a family member or a friend, you can use KMyMoney to keep track of this loan as well.

This guide will assume that you are borrowing from some sort of finance company, but the topics
discussed here apply equally well to loans that you might make to a person. The main difference
between borrowing and lending money is that an expense category is used to keep track of interest
when borrowing money and an income category is used to keep track of interest when lending money.

Loan Principal.  The amount that is lent out is called the "loan amount" or "principal".

Term.  The period of a loan is called its "term" of the loan. At the end of the term, the entirety of the
principal will have been returned to the borrower. Terms are generally expressed in weeks, months, or
years. A term can also be expressed by the number of payments. For example, a one year loan with
weekly repayments could be described as a one year loan or a loan with 52 repayments.

Repayments.  The repayment of the principal to the lender is generally not done as a lump sum.
Instead, a series of repayments are made, each representing a portion of the principal. Such repayments
are sometimes known as "amortization payments" and in KMyMoney "Amortization" is defined as the
act of paying off a loan in installments.

Payment Frequency.  The frequency of installments is referred to as "Payment Frequency" in
KMyMoney. Examples of period might be weekly, bi-weekly, monthly, quarterly, or yearly. In the
US, periodic payments are most commonly made every month, therefore the loan’s period is one 
month.

Interest Rate.  For the privilege of being able to use the money, the borrower will pay the lender a fee
called the "interest", normally expressed as a percentage of the amount of the principal over a defined
period. Interest rates can be fixed, where the interest rate does not change over the lifetime of the loan,
or variable, where the interest rate can change over time. Typically, interest payments are included
with each periodic repayment.

Periodic Repayments.  Since these repayments are generally made on some sort of scheduled basis,
such as weekly, monthly, quarterly, or yearly, they are referred to as "periodic repayments". The sum
of all periodic repayments plus the final repayment will add up to the loan principal plus the interest.

Fees.  There may be other fees besides interest that are required to be paid with every installment.
These are called "recurring fees". Examples of recurring fees include (but are not necessarily limited
to): 

"Impound" or "escrow" account payments. (Payments of this sort are commonly used to hold
funds to pay annual or bi-annual property taxes.) 

Mortgage insurance

Disability insurance

Loan account maintenance fees

Summary.  In summary, the borrower receives a lump sum from the lender at the start of the loan. The
borrower makes a periodic payment to the lender. The periodic payment is the sum of the principal
payment (which is used to pay down the balance of the loan) plus the interest payment (which rewards
the lender for allowing the use of the money by the borrower) plus any recurring fees (which cover any
incidentals.) At the end of the loan, the borrower has paid back the entire principal.
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Example
For an example, you might borrow $25,000.00 for a new auto and agree to pay the bank one payment
each month for 60 months. The interest rate on the loan might be 5.5%.

In this scenario, the loan amount is $25,000.00. The term of the loan is 60 months or 5 years. The term
of the loan could also be described as 60 payments since there will be one payment per month for 5
years. The repayment frequency is one month since periodic repayments will be made once a month.
The periodic repayment, which is calculated by KMyMoney, would be $477.53.

A "loan schedule" is a chart or table that shows the date that a repayment should be made and the
amount of each periodic repayment. Often, these schedules break the periodic payment down into its
constituent parts: the principal repayment, the interest payment, and the recurring fees payment.

Creating a New Loan
In KMyMoney, a loan is a type of account. Therefore, to create a new loan, you begin by selecting
Account->New Account. Continue by answering the questions that the wizard poses to you.

Optionally, a loan can be associated with a particular institution. If you are borrowing from a mortgage
company or a car loan company, you could create an institution entry that describes this firm and
associate the institution with your loan. If you are borrowing from your Uncle Ted, there is no
requirement to set up an institution.

Making Extra Principle Repayments On Loans
If you would like to make an extra principal repayment, you can do so. Simply enter a transaction
using the ledger. This extra repayment of principal will be taken into account for the interest
calculation that happens for the next periodic payment.

Examples of extra principal payments include (but are not necessarily limited to):

Contributing an extra $50 a month

Doubling the periodic principal repayment for every period. (The principal repayment can be
found for any particular period by referring to the loan schedule.) 

Making a 13th principal repayment every year. (This assumes a loan that is repaid in monthly
installments.) 

Note: If you are doubling the principal repaid with every periodic payment, you will need to
recalculate the loan schedule for each installment. This will allow there to be an accurate value for the
required principal repayment with each installment.

Chapter 17. Budgets
Colin Wright <cdwright@gwi.net> 
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What is a budget?
A budget is a categorized list of expected income and expenses for a period.

The Budget facility of KMyMoney allows you to create annual budgets. More than one Budget can be
created for any year. You set monthly Budget values against any Income or Expense categories that
you have defined. The values can be set in three ways, depending on the Period:

Monthly

(Default) specify a single value applied to every month in the Budget

Yearly

specify a single value to divide evenly across each month in the Budget

Individual

specify separate values for each month.

This is used for income and expenses spread irregularly through the year.

KMyMoney provides a number of reports which compare actual income and expenses against the
entered Budgets.

Your budgets
You can access your budgets by clicking the appropriate icon in the navigation pane at the left hand
side of your KMyMoney window.

Creating, changing, and deleting budgets

This section of the Budgets window displays the list of Budgets contained in the current file. If no
Budget has yet been created the list will display a single empty Budget called "Budget <year>" where
<year> is the current fiscal year. The list of Budgets has two columns:

Name

Name of the Budget
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Year

Fiscal year of the Budget

Values from the selected Budget are displayed to the right. To select a different Budget you can click
on the Budget in the list. Alternatively, when the list has focus, you can select a different Budget using
the up and down keys. If you have made changes to a Budget and then select a different budget
KMyMoney will ask you whether you want to discard the changes.

There are five buttons above the list of Budgets.

New

Create a new budget

Rename

Edit the name of the selected Budget.

You can also edit the name of a Budget by clicking on the name of the selected Budget or
double-clicking on the name of a different Budget.

Delete

Delete the selected Budget

Revert

Reverts the selected Budget to its last stored state.

Save

Accepts any unsaved changes to the selected Budget and stores them.

Additional options are available on a menu accessed by right-clicking on a Budget.

New Budget

Create a new, blank Budget.

Rename Budget

Rename the selected Budget.

Change budget year

Displays a window with a list of years to select a different budget year.

Delete budget

Delete the selected Budget.
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Copy budget

Creates a copy of the selected Budget. The new Budget has the name "Copy of <budget>", where
<budget> is the name of the copied Budget.

Account List

The Account List displays the list of Income and Expense Categories. As in other places in
KMyMoney the list is organized in a tree structure. The list can be expanded or collapsed to show or
hide Subcategories within a Category. The Account List has a number of columns:

Account

Account name

Type

Account Type (Income or Expense)

Tax

Checked if a Category included in Tax Reports

VAT

Checked if a Category marked as a VAT Category

Balance

Current balance of Account. Blank for Categories

Value

Total yearly value in the Budget. If an Account has Subaccounts and the Account’s list of
Subaccounts is collapsed the value displayed is the sum of the values for the Account and all of
its Subaccounts.

The Account List can be filtered using "Hide unused Categories". In Budgets this hides any Categories
for which no value has been assigned to the Category or any of its Subcategories.

Assignments

The Assignments area shows the value for the selected Account.

Account

Displays the name of the selected Account. If the Account is a Subaccount, the full name of the
selected Account is displayed in the Account:Subaccount format.

Total
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Displays the total yearly value assigned to the Account

Include subaccounts

In Reports show actual income or expenses in Subcategories belonging to the Category against
the Category instead of the Subcategory.

If a Subcategory has a value defined in the Budget the income and expenses are shown against
the Subcategory.

Clear

The Clear button resets the budgeted account value or values to zero.

Period

The Period radio buttons allow you to select the period for which the value applies

Monthly

A single value is entered, specifying the amount per month. This is the default setting.

Yearly

A single value is entered, specifying the amount per year.

Individual

Values are specified for each Calendar month. This is used where expense or income is
spread irregularly through the year.

If a value is or values are already specified and the Period is changed KMyMoney will ask
whether to use the current total yearly value to assign the new values. 

Update and Revert

For performance reasons, changes made to a Budget are not saved immediately. Instead, they first
have to be stored using the Update button and then permanently saved using the KMyMoney Save.

When a Budget’s values are first modified, the Update and Revert buttons are enabled. Multiple
changes can be made to the Budget. Pressing Update will store the changes, disable the Update and
Revert buttons and enable the KMyMoney Save.

The KMyMoney Save only saves changes that have been stored using the Update button. Thus, if you
have modified a Budget but not yet stored the changes KMyMoney Save will not affect the modified
Budget and the Update and Revert buttons remain enabled.

Revert undoes any changes made to a Budget since the last Update and disables the Update and Revert 
buttons.

Changes stored using Update but not yet saved using KMyMoney Save can only be reverted by
reloading the KMyMoney file.
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Budget Reports
KMyMoney provides a number of reports to compare actual income and expenses against Budgets.
These are listed in Reports under "Budgeting". There are two types of Reports:

Budget only

Reports displaying values from a Budget: Monthly Budget Displays the monthly values from a
Budget. Yearly Budget Displays the monthly values from a Budget, with yearly total.

Compare Budget and Actual

Reports comparing values from a Budget to actual income and expenses: Budget vs. Actual This
Year Month-by-month comparison for the current year so far, with total. Monthly Budget vs.
Actual Month-by-month comparison, defaulting to the current month. Yearly Budgeted vs. Actual
Month-by-month comparison for the whole of the current year, with total. These reports provide a
base from which custom reports can be created by changing the date range and Budget. Of the
Budget reports, only the "Budget vs. Actual This Year" does not allow the Budget to be changed.
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What is a Forecast?
In KMyMoney, a Forecast is a prediction of the balances of Accounts during a specified future period
of time.

Forecasts can be predicted using one of two methods.

Scheduled and Future Transactions

KMyMoney uses a combination of future transactions already entered into the ledgers and the
entries in the Schedule.

History-based

KMyMoney uses values from past transactions in the ledgers to predict future transactions.
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The forecast method and forecast period can be set in the KMyMoney Settings, in the Forecast pane.

KMyMoney Forecast provides a summary, showing the predicted balances at account cycle dates and
the expected difference between the starting and ending balances. The length of the account cycle can
be set by the user. The summary also displays messages about significant predicted changes to the
accounts during the forecast period.

As well as the summary, KMyMoney Forecast also allows you to view day-by-day balances and view
the minimum and maximum balances for each forecast account cycle.

By default the Forecast is created for 90-days, with 30-day account cycles using Scheduled and Future 
Transactions.

Viewing Forecasts
You can view a Forecast by clicking the appropriate icon in the navigation pane at the left hand side of
your KMyMoney window.

The Forecast window is split into three tabs

Summary Tab

The Summary tab is split vertically into two halves.

Account Summary

The Account Summary contains a grid displaying a row of information for each Asset and Liability.

The following columns are displayed:

Account

The name of the Asset or Liability account

Current Balance (Current)

The current balance of the account is displayed.

Account Cycle Balance

The Forecast period is split into account cycles. The default account cycle length is 30 days, but
can be set by the user.

The first account cycle date is the first Forecast date. By default this is the current date plus one
account cycle, but can change depending on the "Day of Month to start Forecast" setting.

Remaining account cycle dates are determined by adding the account cycle length to the previous
account cycle date. This is continued until the calculated account cycle date would be beyond the
Forecast period.
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For each account cycle date the predicted balance is displayed.

Total Variation

The rightmost column displays the predicted difference in value between the balances at the start
and end of the forecast. If the predicted end value of the account (in terms of net worth) is less
than the start value the whole row is highlighted in red.

Key Summary Information

The bottom half of the Summary tab displays noteworthy information about accounts. This includes:

Assets below zero

A message is displayed for any asset for which the value starts or will drop below zero during the
forecast period.

Liabilities above zero

A message is displayed for any liability for which the value starts or will rise above zero during
the forecast period. Note that the value of a liability is the negative of its ledger balance, since a
positive balance indicates money owed.

Details Tab

The Details tab contains a grid displaying a row of information for each Asset and Liability.

Account

The name of the Asset or Liability account

Dates

For each date in the Forecast period a column displays the predicted balance of the account on
that date. The date columns are in ascending order from left to right.

Total Variation

The rightmost column displays the predicted difference in value between the balances at the start
and end of the forecast. If the predicted end value of the account (in terms of net worth) is less
than the start value the whole row is highlighted in red.

Advanced Tab

The Advanced tab contains a grid displaying a row of information for each Asset and Liability. The
information is split into columns as follows:

Account

The name of the Asset or Liability account
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Minimum Account Cycle Balance

For each account cycle number <n> in the Forecast period the following columns are displayed:

Minimum Balance (Min Bal <n>)

The minimum predicted balance during the account cycle

Minimum Balance Date (Min Date <n>)

The date on which the balance reaches its predicted minimum.

Maximum Account Cycle Balance

For each account cycle number <n> in the Forecast period the following columns are displayed:

Maximum Balance (Max Bal <n>)

The maximum predicted balance during the account cycle

Maximum Balance Date (Max Date <n>)

The date on which the balance reaches its predicted maximum.

Average

The average balance of the account during the forecast period

Chapter 19. KMyMoney Settings
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Foreground tab
Background tab

Fonts
Online Quotes
Forecast
Plugins

The settings described below modify the behaviour of KMyMoney. These settings can be changed
through Settings->Configure KMyMoney....

General

Global options

Startup

Choose the initial view upon startup.

Start with home page

Start with last selected page

Price Precision

Enter how many digits of precision your prices will have after the decimal point. For example,
setting this to 2 will result in prices like 35.18, where setting it to 4 might cause the same price to
show 35.1791

Autosave periodically

Check this box if you wish KMyMoney to autosave your files periodically. The default is 10 
minutes.

Your fiscal year starts on

Enter the starting day and month of your fiscal year

Views options

Synchronize account selection of ledger and investment view

If this option is selected, selecting an account on the investments view will change the account
selection on the ledger view, and viceversa.

Icon size of navigation bar

Select the size of the icons of the left-side navigation bar.

Show titlebar on each page
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Whether the title of the current view should be displayed on each page.

Filter options

Don’t show unused categories

Hide unused categories.

Don’t show closed accounts

Hide closed accounts.

Show equity accounts

Equity accounts are normally hidden. Select this option to show them.

Don’t show finished schedules

Hide finished schedules.

Don’t show transaction prior to

Hide transactions prior to the selected date.

Setting this option to January 1, 1900 is a good way to debug date-related file import problems.

Don’t show reconciled transactions

Filter transactions by reconciliation state. Transactions that are marked as Reconciled will not be 
shown.

Register
These options allow you to modify the behaviour of the transaction registers.

Display tab

Show a grid in the register

Show grid lines in the transaction register.

Use the ledger lens

With this option enabled, the ledger will show all lines of detail for the transaction you have
currently selected, even if you have set the Show Transaction Detail menu option turned off.

Show transaction form

Show the transaction form at the bottom of the transaction register for entering and editing
transactions. With this option turned off, you edit the transaction within the register itself.
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Always show a No. field

Always have the number ("No.") field when entering or editing a transaction.

Show group header between transactions

Display group headers in the register

Show header for the previous and current fiscal year 

Display group headers for the current and the previous fiscal year

Sorting tab

Normal view tab

Choose the sort order of the ledger while in the Normal view.

Reconciliation view tab

Choose the sort order of the ledger while in the Reconciliation view.

Search view tab

Choose the sort order of the ledger while in the Search view.

Data Entry tab

Insert transaction type into No. field for new transactions

Automatically place the type of the transaction, e.g., Deposit, Withdrawal, etc., in the No. field.

Auto increment check number

Have the check number automatically increment whenever entering a new check transaction.

Keep changes when selecting a different transaction/split

When enabled, selecting a different transaction or split will save edits to the current transaction.

When disabled, selecting a different transaction will cancel them. Instead, you must explicitly
accept the changes.

Use Enter to move between fields

When enabled, pressing Enter will change the focus to the next field of the transaction form.

Match names from start

Mark this option if you always want to match names e.g., for payees from the start. If unset, any
substring is matched
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Default reconciliation state

Select the default reconciliation state for new transactions.

Auto fill with previous transaction data

Select the desired behavior for autofill or deactivate it

No Autofill

Same transaction if amount differs less than X percent

When entering a new transaction with this option, KMyMoney will display a list of previous
transaction for the payee and account. If previous transactions differ in less than X percent,
they will be considered identical. If the percentage is 0, all previous transactions for the
payee and account will be displayed. When selecting a transaction, all transactions details
except the date will be autofilled with those of the selected transaction.

With previously most often used transaction for the payee

When entering a new transaction with this option enabled, KMyMoney will fill in all the
transaction details based on the previously most often used transaction with the selected 
payee.

Import tab

Match transaction within days

Search for matching transactions within the range of the imported transaction +/- given days

Ask for a new payee’s default category

Whenever a new payee is detected during an import, the user will be asked for the default
category for the payee.

Home
These options allow you to customize the appearance of the Home page by choosing which entries to
show on the Home page and the order in which they appear.

Payments

It shows the first 5 occurrences of your scheduled transactions

Preferred accounts

It shows the balance and credit of your favorite accounts

Payment accounts
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It shows the balance of your asset and liability accounts, except for the investment accounts

Favorite Reports

It shows a list of your favorite reports

Forecast

It shows a forecast for your asset and liability Accounts

Networth forecast

It shows a chart of your forecast net worth for the next 90 days

Assets and Liabilities

It shows the balance of all your assets and liabilities

Budget

It shows the budget items for the current month which have a negative difference compared to the
actual income or expense

CashFlow

It shows an analysis of your cash flow for the current month

Percentage of default font size

Select the size of the font on the Home page

Remember font size when leaving the program if manually changed with mouse-wheel

Selecting this will save your font size preference if you have changed it from the Home page by
using the mouse-wheel

Show account limit information

Shows the limit of the accounts on the Payment Accounts and Preferred Accounts sections of the
Home page

Schedules
These options allow you to modify the behaviour of the scheduling features.

Schedule startup options

Check schedules upon startup

Enables checking the schedule upon startup of KMyMoney.
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Enter transactions this number of days in advance

Specify how many days in advance should the scheduled transactions be entered.

Number of days to preview schedules schedules in ledger

Specify how many days should the schedules show up in the ledger.

The scheduled transactions will be listed in the ledger. You can enter or skip the scheduled
transactions by right-clicking on them.

Encryption
These options allow you to modify the data encryption settings.

Use GPG

Enables the use of GPG to encrypt data file. See the section on GPG Encryption for more details.

GPG Encryption

Your key

Enter the email address or the hexadecimal key id to use for data encryption.

Additional keys

Select additional keys to use for data encryption.

Also encrypt with kmymoney-recover key

Encrypts data with the KMyMoney recover key. Selecting this option will allow core KMyMoney
developers to decrypt your data file in case you lose your encryption key.

Colours
These options allow you to change colors within KMyMoney.

Foreground tab

Modify the foreground colors by clicking on the color button and opening a color select palette.

Background tab

Modify the background colors by clicking on the color button and opening a color select palette.
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Fonts
These options allow you to modify the fonts.

Use system fonts

Select this to use system fonts. Deselecting this option allows you to customize fonts.

Cell font

Specify the custom font to use within each cell.

Header font

Specify the custom font to use for the headers of each view.

Online Quotes
These settings modify how online quotes are retrieved from different online sources.

This tab allows you to change the online quote sources for KMyMoney. Generally speaking, this is an
advanced feature, and should only be attempted by the most technically adept users.

For more details, please refer to to the Online Price Quotes section.

Forecast
These options allow you to modify the forecast options.

Number of days to forecast

Select how many days you want to forecast. The default is 90 days

Number of days of account cycle

The normal number of days that your commonly-used accounts go through an income-expense
cycle. For example, if you receive your salary on a monthly basis, you should select 30 days here.

Day of month to start forecast

Select the day of the month when you want to start the forecast. This would usually be the day
when you receive your salary or other income.

Forecast Method

The forecast method to be used.

Scheduled and future transaction forecasts your balance based on the information of your
scheduled and future transactions.
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History-based uses your past transactions to extrapolate a forecast.

Number of cycles to use in forecast

If using a history-based method, how many previous account cycles should KMyMoney use to
calculate the forecast.

History forecast method

Select the method to use when calculating a forecast based on historic information

Simple moving average averages your past transactions to calculate a forecast.

Weighted moving average averages your past transactions, but it will give more importance to the
most recent transactions.

Linear regression uses a linear-regression formula based on your past transactions to calculate the 
forecast

Plugins
These options allow you to modify the behavior of any installed plugins. Currently, the only choice is
to enable or disable the KMyMoney plugins you have installed.
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General
The Search Transactions dialog searches your data based on criteria that you specify. You can access
the dialog by going to the Edit menu and selecting Find transactions....

There are two main tabs in this dialog. The "Criteria" tab displays a number of sub-tabs for specifying
the search critera.
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The results will be displayed under the "Result" tab after the search has completed. Below the list of
results, KMyMoney shows the number of transactions that met the search criteria. Double-clicking on
an individual transaction in the result list will bring up the appropriate ledger and display the 
transaction.

When the Find button is pressed, the search is initiated and all criteria that have been entered on any
tab will be taken into account.

The Reset button resets all of the fields on all of the critera sub-tabs back to the defaults. This allows
you to specify new search criteria.

The Close button closes the Search Transactions dialog box.

Search Criteria
There are several sub-tabs under the main "Criteria" tab, each of which allows you to specify different
types of search criteria. Below the area for specifying the criteria, KMyMoney lists each of the
different types of criteria that are currently specified for the search.

Text

This tab allows you to speicify text to search for. There are also two check boxes that control how the
text is used in the search.
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By default, this will match on simple substrings. For example:

"Best" will find "Best Cakes, Inc."

"est" will also find "Best Cakes, Inc." 

In the dropdown field next to the text field, select Contains if you want to find transactions that contain
the text, or select Does not contain if you want to find transactions that do not contain the specified 
text.

If you check the Case Sensitive box, the search will be case sensitive. For example, "best" would not
find "Best Cakes, Inc." if this option is set.

If you check the Treat Text as regular expression box, the text will be treated as a regular expresssion.
For details on how to craft a regular expression, visit the QtTM documentation about the QRegExp 
class.

Account

This tab allows you to specify the accounts that should be searched. 

Accounts are displayed in a tree format. Accounts that are marked for search are indicated with a
check box. If you click the All button, all accounts are marked for searching. If you click the None
button, no accounts will be marked for searching. Individual accounts can be marked or unmarked by
clicking on the box next to the account name using the left mouse button. A complete hierarchy of
accounts can be marked or unmarked by clicking on the box using the right mouse button.
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Date

This tab allows you to specify which dates should be searched.

The "Range" control provides a convenient way to set the From and To controls. The From and To
controls can be manipulated individually. Dates can be entered manually. The controls will prevent
you from entering non-existing dates. Date values can also be changed by clicking on the up and down
arrows when a particular part of a date is highlighted. Clicking on the small calendar icon will bring up
a calendar to easily select dates.

Amount
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This tab allows you to specify what amounts should be searched for.

You can search for an exact amount or for a range of amounts. If you click on the calculator icon, a
small on-screen calculator will pop up to assist you in entering a value.

Category
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This tab allows you to specify which categories should be searched. 

Categories are displayed in a tree format. Categories that are marked for search are indicated with a
box. If you click the All button, all categories are marked for searching. If you click the None button,
no categories will be marked for searching. If you click the Income button, income categories will be
marked and expense categories will be unmarked. If you click the Expense button, income categories
will be unmarked and expense categories will be marked.

Individual categories can be marked or unmarked by clicking on the box next to the category name
using the left mouse button. A complete hierarchy of categories can be marked or unmarked by
clicking on the box using the right mouse button.

Payee
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This tab allows you to specify which payees should be searched. 

Payees that are marked for search are indicated with a box. If you click the All button, all payees are
marked for searching. If you click the None button, no payees will be marked for searching. Individual
payees can be marked or unmarked by clicking on the box next to the payee name.

If you check the Select transactions without payees box, only transactions with no payee will be 
selected.

Details

This tab allows you to specify various additional search criteria.
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Type can be one of the following:

All Types

Payments

Deposits

Transfers

State can be one of the following:

All states

Not reconciled

Cleared

Reconciled

Validity can be one of the following:

Any transaction

Valid transaction

Invalid transaction
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You can search for a particular transaction number or search for a range of transaction numbers.

Search results
The "Result" tab displays the Date, Account, Details, Reconciliation status, Payment, and Deposit for
each transaction that matches the search criteria you have entered. Right clicking on the header row of
the results list allows you to alter the sort order of the results.

Double-clicking on a transaction will display the corresponding account ledger and focus on the
selected transaction.

Chapter 21. File Formats
Thomas Baumgart <ipwizard@users.sourceforge.net>
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This chapter describes the formats in which KMyMoney stores its data in permanent form on the
user’s storage device. In general, KMyMoney stores its information in form of an XML document.
Depending on the actual format, this XML document will be written 

as a plain text file encoded in UTF-8,

as a compressed file using GZIP compression,

as an encrypted file using GPG encryption, or

as an anonymous plain text file encoded in UTF-8 but with all your personal data scrambled.

Plain text file
This is the most space consuming format supported, as no compression is performed. It is not intended
for normal use, and is provided to support debugging purposes and the capability to modify the file
manually. If you end a filename in .xml, the file will be stored in this format. 

Caution

Manual modification of the file is not recommended to the normal user, and should only be performed
if the internal working of KMyMoney is fully understood or if instructions from the developers tell
you what to do. Don’t blame the KMyMoney developers if you screw up your data: You have been
warned! 
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GZIP-compressed file
This is the normal format used by KMyMoney when you store a file with the extension .kmy.

Note

If encryption has been selected, the file will be stored encrypted. 

If you want to look at the contents of a GZIP compressed file, rename it to a filename ending in .gz
(e.g., rename myfinances.kmy to myfinances.kmy.gz), then use gunzip to uncompress the
file and look at it. You don’t have to compress it before loading it into KMyMoney the next time,
because KMyMoney can read the uncompressed data as well. Nevertheless, if you save it thereafter, it
will be saved compressed again. Use the .xml extension to write it in uncompressed format.

GPG-encrypted file
Using the GPG-encrypted file format is a very secure method of storing your personal finance data on
your storage device. When KMyMoney has been instructed through the settings dialog to store your
data encrypted, it will cipher the data using GPG and the key you provided before actually storing it.
When opening an encrypted file, you have to provide the passphrase necessary to open your keyring.
The encrypted file itself will be stored in GPG’s ASCII armored format. 

Note

When using GPG encryption, GPG also compresses the file, so no extra compression is necessary. 

GPG-Keys

If you have not done so already for mail encryption, you need to generate a key-pair in order to use the
GPG encryption feature of KMyMoney. Also, GPG must be installed on your system.

The details about how to generate a key-pair and how to take care of it are beyond the scope of this
document. A Mini Howto on this subject can be found at 
http://www.gnupg.org/documentation/howtos.en.html.

Setting the keys in KMyMoney

On the encryption page of the settings dialog, there is a drop down list where you can select the key
that should be used for encryption and decryption. Additionally you can find a field where you can
enter the key-id of a key not in the listbox. You can use either the key-id, the email address associated
with this key, or any other valid GPG key identification as the value for this field. When you enter the
key-id, KMyMoney will check its validity and display a green LED icon in the dialog if a key is
found. 

Caution

Make sure you have both the public and the private key for this id. If you do not own the private key
for the id entered, you will not be able to open the file again. 
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The KMyMoney recover key

Also on this page of the settings dialog you have the choice of selecting supplemental encryption with
the KMyMoney recover key. This option is available to you if that key is stored in your GPG keyring.
Selecting this option will allow you to recover your data even in the case you lose your own private
key. This is possible because the data is not only encrypted for your own key, but also for the
KMyMoney recover key. This key is only available to selected KMyMoney developers (at the time of
writing only to the author).

Under normal circumstances, you will open/save/close your file as usual. In the abnormal case of loss
of your key, you have the chance to contact one of the developers who has access to the KMyMoney
recover key and request help to recover your data. You may contact the developers via email to the
KMyMoney developer mailing list at <kmymoney2-developer@lists.sourceforge.net>.

Anonymous file
This format is not intended to be used for normal data storage. It is supported in case of a problem as a
method of supplying the KMyMoney development team with your file without disclosing any of your
financial data. If instructed by the developers, use the Save as... menu item to store your data in
anonymous format by selecting .anon.xml as the file extension. To verify that your problem still
exists, reload this anonymized file and try to duplicate your problem. If the problem is still present,
send the file to the developer mailing list at 
<kmymoney2-developer@lists.sourceforge.net> for further investigation. If the
problem does not show ... well, I don’t want to think about this scenario right now.

Chapter 22. Database
Tony Bloomfield <>

Revision 1.0 (2009-08-05)
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Caution when using the database

Caution

At the time of writing, the software described in this chapter is still in an experimental stage, and loss
of data is possible. Please ensure that you have an alternative backup copy of your data before
committing to database usage. 
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Introduction

As of release 1.0, KMyMoney allows you to hold your data in a relational database. One of the
advantages of using this industry-standard format is that it may allow you to view your data using one
of the graphic front ends such as OpenOffice.org©, perhaps in some format that KMyMoney currently
doesn’t provide. Also, a little knowledge of SQL (Structured Query Language, the language used
world-wide to access relational databases) should enable you more easily to export data to an external
program, for example, a budgeting application.

Preparation

To access the database, KMyMoney uses the SQL module supplied by QtTM Software as part of their
QtTM programming system. This module supports a number of different database systems through a
collection of drivers. Among the more popular open-source systems for which drivers are available are
MySQL®, SQLite, and PostgreSQL. The module also supports the ’heavier’, more industrial, systems
such as Oracle® and IBM DB2®.

With the exception of SQLite, these systems use a client/server model, where the ’client’ software sits
on ’your’ machine, while the server lives on the same machine as the database itself, which may be
elsewhere on a network. Of course, in the normal scenario for a personal finance application such as
KMyMoney, ’your’ machine acts as both client and server. Your first task therefore, having decided
which database system you wish to use, is to install the client, and most probably server, software.

In addition to the database software itself, you must also install the corresponding QtTM driver
module. Most distributions will include driver modules for the more popular databases. Otherwise,
check with the QtTM software web site and search for ’SQL drivers’

Note

SQLite does not operate on a client/server model; each database is held in a regular file, local or
remote, accessed using the normal methods supplied by the underlying operating system. In this case,
therefore, there is only one software package to install. Also, some of the following information,
particularly that related to administration, may not apply to SQLite. 

Due to limitations in prior releases, only version 3 of SQLite is supported. Unfortunately, the release
of the QtTM toolkit used by KMyMoney does not provide a driver for this version. However, an
unofficial, extensively tested, driver is available; if you wish to use SQLite, ask on 
<kmymoney2-developer@lists.sourceforge.net> for further information. 

Administration

Looking after databases is a little more complex than dealing with regular files. Each system has
different methods for performing those necessary administrative tasks such as creating databases,
assigning permissions to various users, producing backups, etc.. Describing these tasks is outside the
scope of this manual, but all of the supported products provide comprehensive reference
documentation, and a quick search of the web will point you at many tutorials on the subject.
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Creating the database

Code has been included to create an initial database to hold your data if one doesn’t exist. However, it
is strongly recommended that you pre-create a database, because most of the products provide a
number of options which may be relevant. One that may be of particular importance to some would be
the designation of the character set (e.g., UTF-8) to be used for text fields.

At this time, you will also need to specify permissions for various users to perform different operations
on the database. In most systems, the user who creates the database will be automatically assigned all
permissions, but this is an area in which the documentation should be consulted.

For your first use of the database, and occasionally at other times when the database layout changes,
you will need permission (also called privileges) to create and alter tables and views (see next
paragraph). There may be different names for the permission/privilege in different systems, but
something like CREATE and ALTER should be commonplace. For normal running, you will need to
be able to read and write records; these are normally defined in SQL as SELECT, INSERT, UPDATE,
and DELETE permissions.

Creating Tables

On your first use, KMyMoney will attempt to create the necessary table structures. In order to achieve
the maximum compatibility between various database types, only a subset of common data types are
used. There may nevertheless be situations where a particular type is not supported, and in this case,
provision has been made to generate the SQL code necessary to create tables. This code can then be
modified as required and used to create the tables outside of KMyMoney. Should you find yourself in
this situation, help can usually be obtained from 
<kmymoney2-developer@lists.sourceforge.net>.

Initialisation

Using KMyMoney, open or import an existing data file, or create a new one. Then select Save as
Database from the File menu. This will present the following dialog:
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Database Type

This box lists all QtTM SQL drivers installed on your system. Select the driver for your database type.
If the one you want is not in the list, you need to install the appropriate driver. See your distribution
documentation, or visit the QtTM software web site and search for ’SQL drivers’.

Database name

The default database name is KMyMoney, but you may choose some other name if you like. SQLite
has one database per file; selecting this driver will open the standard ’Open File’ dialog from which a
file may be selected or created. For some database types, KMyMoney may not be able to create the
database, so it must be pre-created using the appropriate administrative procedure. However,
KMyMoney will create all table structures where necessary.
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Host name

For the average user, the default name of "localhost", being the machine you are currently using, is
correct. For networked databases, enter the connected host name.

Note

NOTE: For SQLite databases, the Host name, User name, and Password fields are not relevant. The
SQLite file must have the appropriate read/write permissions set by the underlying file system to
enable the appropriate access for the currently logged-in user. 

User name and password

Check the permissions set up on your database, or contact the database administrator, for the correct
values to use here. The user name must be capable of selecting, inserting, updating, and deleting
records. If the user name is the same as your login name, a password is not normally required.

Generate SQL

This button will generate the CREATE TABLE commands and save them to a text file, which may be
edited if the in-built commands do not work for your database system (see previous paragraph).

Accessing your data

Table design

To access your data in KMyMoney, use the Open Database entry in the File menu. This will open a
dialog similar to the above.

To access your data in other formats, you will need to know a little about how it is held in relational
databases. By far the easiest way to get a feel for this is to open the database in a front-end such as
OpenOffice.org. This provides a list of the various tables which make up the database, and enables you
to see the layout of each of them.

To extract data, e.g., into a spreadsheet or external file, it is almost invariably necessary to select
linked data from more than one table. This is done by ’joining’ the tables, using a field which is
common to each. You can find a lot more information about how this is done from the online database
tutorials mentioned above. The following table lists the fields used to define these inter-table 
relationships.
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Relationship Match With

Institutions and Accounts kmmInstitutions.id kmmAccounts.institutionId

Accounts Parent/Child kmmAccounts.id kmmAccounts.parentId

Transactions and Splits (see
Note 1)

kmmTransactions.id kmmSplits.transactionId

Accounts and Splits kmmAccounts.id kmmSplits.accountId

Payees and Splits kmmPayees.id kmmSplits.payeeId

Schedules and Transactions kmmSchedules.id kmmTransactions.id

Transactions and Currencies kmmTransactions.currencyId kmmCurrencies.ISOCode

Accounts and Securities (see
Note 2)

kmmAccounts.currencyId kmmSecurities.id

Securities and Prices kmmSecurities.id kmmPrices.fromId or 
kmmPrices.toId

Currency Rates kmmCurrencies.ISOCode kmmPrices.fromId or 
kmmPrices.toId

Notes:

1 - txType = "N" for normal transactions, "S" for scheduled transactions

2 - if kmmAccounts.isStockAccount = "Y"

Field formats

Several of the data fields are held in an internal format which may not be immediately useful to
external programs. In these cases, the information has been duplicated in both internal and external 
formats.

Monetary amounts and share values are shown both in numerator/denominator format, and, with a
field name suffixed with ’Formatted’, in the form as shown on your screens.

Similarly, some fields, such as account type appear both as a numeric code, and in a field suffixed
’String’ in the form and language of the application.

Updating your data

Having data in an industry standard format does give you the ability to modify it outside the
KMyMoney application. DO NOT DO IT unless you really know what you are doing, and always be
certain to make a backup copy of your data first. If you get it wrong, KMyMoney may not be able to
access your data, and you could even end up losing it altogether. You have been warned!
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Stored queries

Most database systems allow you to store commonly used queries and procedures, and in some cases,
these may be held as tables or other objects within your database itself. As you will have guessed from
the above, all the tables used by KMyMoney begin with the lowercase letters ’kmm’. This standard
will be maintained, and only tables beginning with these letters will be updated. Thus, provided you
avoid these in the naming of your queries etc., you should not experience any problems.

Encryption

Encryption of data in your database is not currently supported.

Chapter 23. Reference
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Menus
Roger Lum <rogerlum@gmail.com>

Below is a complete list of the menu selections in KMyMoney, with a very brief description of what
each one does. Note that many of these menu choices will be unavailable, or grayed out, depending on
the current display or state of the application. For example, you are not able to edit an account unless
you have an account selected or displayed in the current view.

File Menu

File->New (Ctrl-n )
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Creates a new empty KMyMoney data file. Only one KMyMoney file can be open at once, so this
will close your current file first, if one is open. 

File->Open (Ctrl-o )

Opens an existing KMyMoney data file.

File->Open Recent->...

Allows quick access to recently opened files.

File->Open Database...

Opens an existing database.

File->Save (Ctrl-s )

Saves the currently open file.

File->Save As...

Saves the currently open file with a different filename.

File->Save As Database...

Saves the currently open file in a Database.

File->Import->...

Imports financial data from other file types, such as QIF and Gnucash, or a template file of
accounts and categories that can be used in setting up new accounts.

File->Export->...

Exports the current file as a different file type, such as QIF, or exports a list of your accounts and
categories as an template. 

File->Print (Ctrl-p )

Prints the current file.

File->Backup

Saves a backup the current file.

File->Personal Data

Allows to edit personal data.

File->File information

Displays information about the currently open KMyMoney file.
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File->Close (Ctrl-w )

Closes the current file.

File->Quit (Ctrl-q )

Quit KMyMoney

Edit Menu

Edit->Find transactions... (Ctrl-f )

Search transactions.

View Menu

Settings->Show Transaction Detail (Ctrl-t )

Shows transaction details in the Ledger view. With this option turned on, all lines of the
transaction will be shown in the ledger. When it is turned off, only one line will be shown. 

If you only want to see details for the currently selected transaction, but only one line for the
others, you can turn on the Ledger Lens. 

View->Hide reconciled transactions (Ctrl-r )

Hides reconciled transactions on the register.

View->Hide unused categories (Ctrl-u )

Hides unused categories on the views.

View->Show all accounts (Ctrl-Shift-a )

Shows all accounts on the views.

Institution Menu

Institution->Add new institution...

Add a new institution.

Institution->Edit institution...

Edit an institution.

Institution->Delete institution...

Delete an institution.
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Account Menu

Account->New account...

Adds a new account.

Account->Edit account...

Edits an account.

Account->Delete account...

Deletes an account.

Account->Open ledger

Displays the ledger view of an account.

Account->Reconcile... (Ctrl-Shift-r )

Reconciles an account through the reconciliation wizard.

Account->Postpone

Postpones reconciliation of an account.

Account->Finish

Finishes reconciliation of an account.

Account->Transaction report

Opens a transaction report of an account.

Account->Close account

Closes an account.

Account->Reopen account

Reopens an account, if closed.

Account->Unmap account

Unmaps an online account.

Account->Map to online account

Maps an account to an online account.

Account->Update account...
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Imports transactions from online banking for an account

Account->Update all accounts...

Import transactions from online banking for all accounts.

Category Menu

Category->New category...

Adds a new category.

Category->Edit category...

Edits a category.

Category->Delete category...

Deletes a category.

Category->Open ledger

Displays the ledger view of a category.

Transaction Menu

Transaction->New (Ctrl-Insert )

Adds a new transaction.

Transaction->Edit

Edits a transaction.

Transaction->Edit splits

Edits the splits of a transaction.

Transaction->Delete

Deletes a transaction.

Transaction->Duplicate

Duplicates a transaction.

Transaction->Mark transaction as ...->Not Reconciled

Changes a transaction to Not Reconciled status.

Transaction->Mark transaction as ...->Cleared (Ctrl-Shift-Space)
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Changes a transaction to Cleared status.

Transaction->Mark transaction as ...->Reconciled (Alt-Ctrl-Space)

Changes a transaction to Reconciled status.

Transaction->Go to account

Displays the other account of a transaction.

Transaction->Go to payee

Displays the Payee view and focuses on the payee of the selected transaction.

Transaction->Create scheduled transaction...

Creates a new scheduled transaction.

Transaction->Match

Matches imported transactions.

Transaction->Unatch

Unmatches a transactions that KMyMoney has proposed as a match of imported transactions.
Note that this menu choice is only present if a matched transaction exists. 

Transaction->Accept

Accepts a proposed merge of imported transactions.

Transaction->Select all (Ctrl-a )

Selects all transactions on the register.

Tools Menu

Tools->QIF Profile Editor...

Modifies the QIF profile used to import or export QIF files.

Tools->Securities...

Lists all the current securities, with the ability to edit each one.

Tools->Currencies...

Lists the currencies known to KMyMoney.

Tools->Prices...

Lists stock and currency prices.
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Tools->Update Stock and Currency prices...

Updates stock and currency prices from online sources using the Online Price Quotes feature.

Tools->Consistency Check

Runs a check on your file and tries to fix any problem it finds, if possible.

Make a backup of your file before running this option.

Tools->Performance-Check

Runs a performance test on your file and displays the results.

Settings Menu

Settings->Hide/Show Toolbar

Toggles the toolbar on or off.

Settings->Hide/Show Statusbar

Toggles the bottom status bar on or off.

Settings->Enable all messages

Re-enables any messages you may have turned off by checking Don’t tell me about this again in a
dialog box.

Settings->KDE Language Settings...

Allows to change many locale based settings.

Settings->Configure Shortcuts...

Configures custom shortcuts.

Settings->Configure Toolbars...

Customizes KMyMoney toolbars.

Settings->Configure KMyMoney...

Configures KMyMoney settings.

Help Menu

Help->KMyMoney Handbook (F1)

Accesses the KMyMoney Handbook.

Help->What’s This? (Shift-F1)
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Activates the "What’s This?" cursor for pop-up help.

Help->Show tip of the day

Shows tip of the day.

Help->Report Bug...

Reports a found bug. Please refer to the section on Writing High Quality Bug Reports for
guidance on how to write the most useful bug reports.

Help->Switch application language...

Selects the language used in KMyMoney

Help->About KMyMoney

Shows About KMyMoney information, including the version number and the credits.

Help->About KDE

Shows KDE information.

Widgets
Thomas Baumgart <ipwizard@users.sourceforge.net>

KMyMoney has some specific widgets not found in other applications. The usage of these widgets is
explained in this chapter.

Date entry widget

Whenever KMyMoney needs information about a specific date, e.g., the posting date of a transaction
or the opening date of an account, it offers the user the date entry widget. This widget consists of three
fields and a button. The fields present the day, the month, and the year, separated by the date separator
characters specified by your locale settings. The button - if pressed - opens the datepicker widget.
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Within the date entry widget, the left/right cursor keys can be used to switch between the day, the 
month, and the year fields. Using the up/down cursor keys, the value of the selected field can be
incremented/decremented. The + and - keys can be used to increment/decrement a single day. Month
and year boundaries are considered and incremented/decremented if necessary. Pressing t will set the
date to today’s date.

The date can also be changed using the mouse. Clicking on the day, month, or year field selects the
field. The value can then be incremented/decremented using the arrow buttons on the right of the
widget. They act exactly the same as the up/down key.

The datepicker opens when the button to the right of the arrow buttons is pressed. It shows four arrow
buttons at the top, two on each side of the currently selected month name and year. The leftmost
buttons are used to decrement the year and the month; the buttons to the right of the year are used to
increment the month and the year. The button to the very right closes the datepicker.

Beneath the buttons, the widget presents a calendar page for the selected month. Clicking a day on the
calendar selects that date, closes the datepicker, and transfers the selected date into the day, month, and 
year fields.

At the bottom of the datepicker widget, there are a button, a text edit field, and a combo box. Pressing
the button selects today’s date in the datepicker. The text field can be used to enter a specific date.
Pressing the RETURN key shows that date in the datepicker widget. The combo box allows the user
to select a specific week, and continue to pick a date from there.

Value entry

The value entry widget consists of a text field (that accepts digits, thousands separators, and decimal
symbols) as well as a button to the right. Use the digits to enter the value. Separate the fractional part
by entering the decimal separator for your locale. If you click on the button to the right or press a key
representing a numeric operation (e.g., +,-,/,* or %) a little calculator will pop up and allow you to
calculate the final value.

Negative values can be entered by preceeding the value with a minus sign. In case your locale is set to
display negative numbers with parantheses around the value, the value can also be enclosed in
parenthesis in the value entry widget.
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Use the calculator widget just like a normal calculator and once done leave it by clicking on the ’=’
button or press the ’=’ key on your keyboard.

Payee/Payer entry

When you are requested to enter a payee/payer for a transaction, you can start entering the name by
pressing keys on your keyboard. As long as matching entries exist in the list of payees/payers
maintained by KMyMoney they will be presented in a box beneath or above the text entry area. Using
the mouse or the up/down keys one can select a name from that list. Using the keyboard additionally
requires you to select the entry by pressing the RETURN key.

If a name is entered that is not yet known to KMyMoney you will be asked if you want to create a new
payee/payer record. If you do not wish to do so, then the field will be blanked. Otherwise, the record
will be created and added to the list.

Once the edit field contains characters, the list only shows those payees that match the character
sequence entered. Double-click on the arrow of the combo box to show all payees in the list.

Category/account entry

When you are requested to enter the name of a category or account, you can start entering the name by
pressing keys on your keyboard. As long as matching entries exist in the list of categories/accounts
known to KMyMoney they will be presented in a box beneath or above the text entry area. Using the
mouse or the up/down keys one can select a name from that list. Using the keyboard additionally
requires you to select the entry by pressing the RETURN key.
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If a name is entered that is not yet known to KMyMoney you will be asked if you want to create a new
category record. If you do not wish to do so, then the field will be blanked. Otherwise, the record will
be created and added to the list.

Once the edit field is filled with characters, the list only shows those categories/accounts that match
the character sequence entered. Double-click on the arrow of the combo box to show the complete list.

Chapter 24. Credits
Revision 1.0 (2009-08-10)

Table of Contents

Original Author
Active Developers
Developers of Previous Versions
Special Thanks

Program Copyright (c) 2000, 2001, 2003, 2004, 2005, 2006, 2007, 2008, 2009 The KMyMoney
Development Team

Documentation Copyright (c) 2000, 2001, 2003, 2004, 2005, 2006, 2007, 2008, 2009 The KMyMoney
Development Team

Original Author
Michael Edwardes <mte@users.sourceforge.net>.  Original idea, much intial source code.
Project admin. 

157



Active Developers
Thomas Baumgart <ipwizard@users.sourceforge.net>.  Release manager and de-facto
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This documentation is licensed under the terms of the GNU Free Documentation License.

This program is licensed under the terms of the GNU General Public License.
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